
1. CAPABILITIES 

Pressworks is the latest incarnation of Timeworks Desktop 
Publisher, written by GST Software. The change of name is 
purely for commercial reasons, Timeworks' being owned by 
the American Timeworks Corporation (the program is sold as 
Timeworks Publish It! in the USA). GST can now sell the 
program under the same name around the world. Having 
been successfully developed through a number of versions, 

Pressworks is now a powerful, flexible and versatile program, 
and is useful for publishing a wide range of documents, from 

single-page posters, invoices and flyers through newsletters 

and magazines to full-length books. It is, in fact, being used 
to prepare the camera-ready copy for this book. 

Overview 

In essence, DTP programs allow text and graphics to be 
placed on a page. There are, of course, any number of 
programs which allow this, including many word processors 
and graphics packages, but DTP programs do it with the 
precision and control necessary for high-quality publication. 
In the case of Pressworks, this means the ability to place 

items to an accuracy of 1/100 of an inch or centimetre, 
depending on the unit in use. 

DTP programs also generally exceed the capacities of 

even advanced word processors in the way text can be 
flowed around graphics. Word processors may allow this to 
some extent, but DTP programs generally allow flow around 
irregular shapes, not just rectangles. 
DTP programs also allow great control in the way in which 

typographical features such as leading (line spacing) and 
inter-paragraph spacing are specified. Word processors often 
require these to be specified in terms of lines, that is, 

single-line or double-line spacing. DTP programs allow the 
use of the typographer's unit, the point ( 1/72 of an inch 
approximately). This obviously allows much finer control. 
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Though Pressworks, like most DTP programs, does have 
basic capabilities for text entry and graphics creation, these 
do have limitations. Though it is possible to produce a 
complete document using Pressworks alone (and this is 
quite practical for things like posters and notices) it is much 
more normal to use other programs to prepare large 
amounts of text and complex graphics, and to use Press-
works to assemble them. Pressworks uses the Microsoft 
Windows environment, and is compatible with many drawing, 
painting and word processing programs. Items can be added 
to documents by importing files, by using the Windows 
Clipboard, or by using Object Linking and Embedding (OLE). 
This allows items to be edited in situ, at some expense of 
document file size. 

Page Layout 

Pressworks is consistent in the way it handles text and 
graphics placement, as both of these are contained in 
'frames'. Frames are rectangular areas which are drawn on 
to the page on-screen. The frames can be either displayed 
or hidden on the screen, but are not printed on the page, 

though they can optionally be given a border which will print. 
Once drawn, either a text item or a graphic may be placed 

in the frame. Each frame can contain just one item. If you 
have placed a text file into a frame and it does not fill it, you 
cannot add another file to the frame to fill it (though you can 
add text to the original file from the keyboard). It is, however, 
possible to flow a long text file from frame to frame. This can 
be done automatically, known as 'autoflow', and it is even 
possible for extra pages to be added automatically until all 

the file is placed. This is an invaluable feature for producing 
books. There are limits to the number of frames you can 
have, but at 100 to a page and 8192 in a document, it would 
take a determined effort to reach them. 
There is a slight exception to the 'one item per frame' rule. 

It is possible to use the drawing facilities to add simple 

graphics to frames which contain text or imported graphics. 
This is useful for rules and simple decorations. 
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Frames can be drawn and placed visually using the mouse 
(Pressworks cannot be used without a mouse), or they can 
be sized and placed to a high accuracy from a dialog box, 
typing in the exact dimensions required. These methods can 
also be combined, drawing a frame roughly and then using 
the dialog to adjust the dimensions. 
Frames can overlap. When this is done, text in a frame can 

be ' repelled' by a frame drawn above it. This is how text can 
be flowed around graphics (or indeed other text). Frames 
can also be drawn over graphics for labelling or captioning. 
The background to frames can be either opaque or 
transparent. Combinations of repelling or non-repelling and 
transparent or opaque can be used to produce various 
effects. A combination of transparent and non-repelling, for 
example, could be used to place text over a graphic with the 
graphic showing through. Repelling and non-repelling only 
applies to text in other frames. You cannot repel graphics. 

This means it does not matter whether frames over graphics, 
for example for labelling, are repelling or non-repelling. 
Frames can be given a background tint. This is useful to 

make selected frames stand out on an otherwise white page. 
By making the tint black (or very dark) and. the text colour 
white (or very light) inverse or `negative' text can be 
produced (but some printers cannot print this). 

Templates 

In documents such as books where there are usually many 
pages with the same or similar layouts, it would be a 
considerable chore to have to draw the same frames on 
each page. Pressworks uses a system of `master pages'. 
The master pages are set up with the paper size to be 

used, and the margin settings and column guides. The 
number of columns to be used (from 1 to 9) and the space 
between them can be set. The column guides do not force 
the number of columns, but act as guides when drawing 
frames. Frames can be made to snap* to these guides. 
Master pages can carry frames, fixed text, and graphics. 

Frames are the most useful, but graphics can be used to 
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include a company logo on every page, and fixed text can be 
used for running document titles. When you add pages to 
your document, either manually, or automatically if you are 
using autoflow, the items included on the master pages will 
be included on the added page(s). Headers and footers can 
be included on the master pages, and these can be used for 
automatic page numbering, along with other things. 
With some layouts, left and right pages must be different. 

An example of this is where extra margin width must be 

provided on the ' inside' edge of the page to allow for binding. 
A Pressworks document may have one master page where 

all pages will be the same, or two pages where left and right 
will be different. 
You may want to produce a number of different documents 

with the same general layout. For example, a book may be 
produced with each chapter as a separate document (this is 
standard practice), and you may want to produce several 
books, or several editions of a newsletter with the same 
design. Pressworks allows the master pages to be saved as 
a template. The template can then be used for any number 
of documents. 
As well as saving just the master pages in the template, 

the first page can be saved as part of it. This is useful where 
the first page will be a title page with a special layout. It is 
also possible to design a document with a fixed number of 
pages and save all the pages in the template. This can be 

useful for magazines where a fixed overall design will be 
used for each issue. Further pages can still be added to such 
a document, and will, as usual, take their form from the 
master pages. 
You can see from this that the Pressworks template 

system is quite flexible, and it is this which makes the 
program suitable for single page documents, long multi-page 
documents, and anything in between. 

Compatibility 

Pressworks can read a number of file formats of popular 
programs for the importing of text and graphics files. These 
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include both Windows and DOS programs, and the latter 
includes some formats belonging to the now almost defunct 
GEM environment, which was used by previous versions of 
Timeworks. 
When you import text files into Pressworks, exactly what 

you get depends on the degree of compatibility between the 
originating program and Pressworks. Generally it is better for 
Windows-based word processors than for DOS ones. In the 

worst cases, all you will get is the text, and all styles 
(paragraph styles, bold, italic, etc.) will be lost. 

It is advisable to experiment by importing a file written with 
the word processor you will be using, to see exactly what 
happens. The file should use whatever facilities your word 
processor uses for defining paragraph styles (headings, body 
text, bullets, etc.) and also local changes of style, such as 
bold, italics and underlining, affecting only some words or 
characters within paragraphs. 

With the word processor used by the Author (Word for 

Windows) all paragraph styles are preserved. When a file is 
imported, the paragraph styles in the Word template are 
added to the styles defined in Pressworks. This means that 
the correct fonts and styles applied to the whole paragraph 
will be used in the Pressworks document. Local changes of 
font or style (e.g. italics) within a paragraph are also carried 
over correctly. This is an improvement from Timeworks 3. 

If your word processor format is not supported by 
Pressworks, it is still possible to use it if it can save plain 
ASCII text. Most word processors can save in this form. If 
using ASCII, it is still possible to give paragraphs styles at 
the writing stage by using 'tags'. Tags are special sequences 
of characters which cause the text which follows them to 
take on a paragraph style or a style such as italic or bold. 

This process is described in Chapter 3. If you do not use 
tags, the file can be styled manually after importation. If the 

file is mostly body text, this will not be too much work, as 
untagged paragraphs are automatically given the body text 

style. It will simply be necessary to go through and change 
the style of any headings. 
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Word Processors 

Pressworks is compatible with the following word processors. 
This list includes some formats which are used by several 

word processors. In addition to the formats listed here, 
Pressworks can also import ASCII and DOS Text formats. 

1st Word Plus is a program produced by the same company 
as Pressworks, GST. 
DCA/RFT is a format which can be generated by a number 

of programs, including the following, some of which are, 
frankly, obsolete. 

Lotus Manuscript 

Displaywrite Ill and IV 

Volkswriter 3 

Office Writer 

WordStar 2000 

Samna Word 

Do not confuse RFT with RTF (see below). They are quite 
different. There are various versions of DCA. Pressworks 
may not successfully read all of them. 
Microsoft Works is an 'integrated package' of office 
programs which includes a word processor module. Press-
works reads the .wps format. 
Rich Text Format is a format which allows a lot of style 
features to be included in files which use only text 
characters. It was originated by Microsoft as an attempt at a 

universal exchange format. Most Microsoft word processor 

products can save in this format, but it is also popular with 
other word processors, especially those which run under 
Windows. Pressworks can also export text in this format. 
Windows Write is the simple word processor which is 
supplied with Microsoft Windows. Pressworks can read the 

.wri format which Write saves in by default. Write can also 
save plain text files. 
Microsoft Word (DOS) files can be read by Pressworks. 
Like many word processors, the extension .doc is used by 
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these. Word can also save in RTF format. You may find this 
has advantages in carrying over styles. 
Microsoft Word for Windows .doc files can also be read by 
Pressworks. This is perhaps the most compatible of the word 
processors usable with Pressworks. Like Word for DOS, it 
can also save in RTF format, but this is unlikely to have any 
advantages over using the native .doc format. 
WordPerfect is a very popular DOS word processor which 

exists in many versions. Pressworks can read text files 
prepared with versions 4.x and 5.x. 

WordStar is another well-known word processor, though not 
nearly as popular now as it was in its heyday. Pressworks 
can read WordStar .doc files. 

Graphics Programs 

Graphics programs can be divided into two categories, those 
which produce bitmaps and those which produce some kind 
of metafile. Bitmap programs normally have 'paint' in the 
name, whereas programs which produce metafiles normally 
include 'draw'. Scanners also produce bitmaps, in the same 
formats as paint programs, and screen shots are also 
bitmaps. 

The same dialog is used to import both types of file. The 
following is a list of the programs and file formats supported. 
As with text files, some formats are used by more than one 

program, and some programs can use more than one 

format. It is now common for graphics programs to be able 
to save in several formats, and draw-type programs may 
also be able to save pictures in bitmap form. 
Like text files, if more than one format can be used for a 

given picture, it is possible that the way the picture looks 
when imported may be different. Changes are most likely to 
occur in polylines, pattern fills and fonts used. Changes are 

less likely to happen with bitmaps than with line art. 
1st Design is GST's low-cost drawing program. When you 

try to import a file in its native . art format, you will be 
presented with a message box instructing you to transfer the 
graphic using the clipboard instead. To do this, you must 
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start 1st Design, use Select All on the Edit menu to ensure 
you copy the whole graphic, and then use Copy on the Edit 
menu to copy it to the clipboard. You must then switch back 
to Pressworks, make the frame to take the picture active, 
and then select Paste from the Pressworks Edit menu. 
This is no problem if you own a copy of 1st Design. 

However, if you want to use a graphic drawn by someone 
else, get them to save it in one of the other formats the 
program supports. The Windows Metafile format (.wmf) 
would be the first choice, though the two programs have 
several in common. 1st Design can actually save graphics in 
either metafile or bitmap form. Metafiles are generally 
preferable as they allow scaling without loss of quality. 
AutoCAD and AutoSketch slide (. s1d) files can be imported. 
Though these two programs are drawing programs and 
mainly use metafile-type formats, the slide format is a bitmap 

(in fact, a screen shot). This means the quality may not be 
acceptable, especially if scaled up to any extent. With the 
versions of these programs which use Windows (AutoSketch 
for Windows, AutoCAD LT and some other versions) it is 
generally better to use the clipboard to transfer drawings. 
AutoSketch for Windows (releases 1 and 2) are also OLE 
servers, and this can be used to include drawings into 
Pressworks documents, provided both programs are in-
stalled on the machine. 

CGM is a metafile-type format which is used by a number of 
graphics programs. However, many of these also now use 
the .wmf format. This should always be used in preference 
when there is a straight choice. 
Designworks is the more advanced graphics program 

produced by GST, and is in many ways the ideal companion 
program to Pressworks. See 1st Design above for a 
description of what happens if you try to import a file in . art 
format. As with 1st Design, you can use the .wmf format if 
you need to use a file on a computer which does not have 
Designworks installed. 
The latest version of Designworks (Designworks 2) sup-

ports OLE at server level. This means that it can be used to 
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link or embed graphics into Pressworks documents. This is a 

very convenient way of working if the graphic is likely to be 
edited during the production of a document, provided both 
programs are installed on the computer. 
Encapsulated PostScript is a format which is most useful if 
you have a PostScript printer. If the file incorporates a 
screen version of the graphic, this will be displayed on the 
monitor. If it does not, the frame occupied by the graphic will 
show just a cross. These files have the . eps extension. EPS 

graphics are the only ones Pressworks can rotate. 

GEM Metafile (.gem) format was used by the GEM Draw 
and GEM Artline programs, among others. As GEM has all 
but died out now, this format is little used and is only likely to 
be useful for existing drawings. Its inclusion here shows 

Pressworks' origins in the GEM-based Timeworks program. 
GEM Bitmap (. img) format was used by GEM Paint, and, 
like the GEM metafile format, is now largely obsolete. 

However, some older hand scanners use this format. 
Lotus 1-2-3 pictures can be imported using the native . pic 
format. 
PC Paintbrush pictures can be imported using the . pcx 
format. This format is also used by many other programs, of 
both the Paint and Draw types (it is a bitmap format). The 

only problem is that there are several versions of this format, 
varying in the number of colours supported, among other 

things. Various versions may be imported with varying 
degrees of success. This format is also supported by many 
scanner programs, but the Author would always prefer to use 

.img or . bmp if available. 
TIFF (Tagged Image File Format) with the extension .tif, 
does not belong to any program, but is a supposedly 
standardised bitmap format. Unfortunately, it is not very well 
standardised, and is getting a bit long in the tooth. It is still 

used by many graphics programs and by scanners, but the 
Author, as with . pcx, would always prefer to use . img or 
.bmp if available. 
Windows Bitmap (. bmp) format is the standard Windows 

bitmap format. It is used by Windows Paint, the painting 
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program supplied with Windows, and by many other graphics 
programs and by scanners. This should be your first choice 
of bitmap format where such a choice is available. 
Windows Metafile (.wmf) format is the standard Windows 
metafile format. There are two formats using this extension. 
Pressworks expects the most common of these, the Aldus 
Placeable Metafile format. This format has a 22-byte header 

which gives the size of the metafile and other information the 

importing program can use. The extension is also used by 
'headerless' metafiles, which contain only drawing instruc-
tions. If you have difficulty importing a file with a .wmf 

extension, it is probably of this type. 
Virtually all graphics programs which can save files with 

the .wmf extension save in the Aldus Placeable Metafile 
format. With such programs, this should be your first choice. 

The Screen 

%artworks - [Untitled] 
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Figure 1.1 The Pressworks Screen 

The Pressworks screen (see Figure 1.1) is a fairly normal 
Windows screen. At the top is the menu bar, and below this 
the toolbar. The toolbar contents will change, depending on 
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what mode you are working in, described later in this 

Chapter. 
Rulers are displayed to the left and top of the main area of 

the screen. These will display in the current units, which you 

can change. These rulers can be turned off from the Options 
menu to leave a larger working area if required. The option 

to change the units is also on this menu. 
Below the main area are three lines of information. These 

are an info line (very bottom), a colour palette, and a line 
displaying the current page number, with buttons to change 
pages. The info line and palette can be turned off if required, 
again from the Options menu. 
The window 'floating' in the work area is called the 

'browser'. This is quite important. Exactly what it displays 

changes from mode to mode. In 'Frame' mode, it displays 
imported stories and pictures. In 'Text' mode it displays text 

styles. In ' Paragraph' mode it displays paragraph styles. It is 
hidden in 'Draw' mode, as it serves no purpose here. It can 
be hidden in all modes, from the Options menu again, if you 

want to keep the screen clear. This window may be dragged 
to any convenient place on the Pressworks window. 

Working Modes 
Pressworks is a modal program. It has four modes, and 

which mode you are in controls what you are able to do at 
any given time. You can quickly switch from mode to mode 

using the four mode buttons on the left of the toolbar. 
Though modal working runs against current thinking of how 

software should be designed, for programs as complex as 
DTP, it makes sense. One problem with using word 
processors to assemble complex documents is that they are 
generally non-modal, and you may find that you select text 

when you intend to drag a graphic, or vice versa. This does 
not happen with Pressworks, as these two operations are 
performed in different modes. 
The four modes are frame mode. paragraph mode, text 

mode and draw mode. They control what you can do when 
actually working on the document. Certain operations, such 
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as importing text and graphics, can be performed from any 
mode, though the mode you are in may affect the result of 

the operation. 

Frame Mode 

Frame mode is used to draw frames on the page, 
to adjust the size of frames, and to move them or 
delete them. These operations can only be 
performed in frame mode. Figure 1.2 shows the 

screen in Frame mode. In this mode, new frames can be 
drawn simply by placing the mouse pointer where you want 
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Figure 1.2 The Frame mode screen 

the top left corner, and dragging to the lower right corner. 
When you click in a frame, it becomes the current active 

frame. 'Handles' appear at the corners, and, if the frame is 
large enough, at the midpoints of the sides. These handles 
can be used to resize the frame, by dragging on them. The 

active frame can be deleted by choosing Delete from the Edit 
menu. It can also be copied or cut to the clipboard, with 
contents if any. 
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Dragging with the cursor within the active frame will move 
it. An outline will move with the cursor as a guide to the new 
location. 

If you want to draw a new frame within an existing frame, it 
is important that the existing frame is not the active frame. If 
it is, you will move it instead of drawing a new frame. This 
can be a source of much frustration for inexperienced users. 
You can de-select a frame by clicking anywhere outside it. 

If you import a text or graphic file while in frame mode, and 
if a frame is active, the file will be placed in that frame. 
Otherwise, it will be stored and its name listed in the 
browser. 
Stories and graphics from the browser are also placed in 

frame mode. To do this, you make a frame active by clicking 
in it, and then click on the story or graphic. 

If only part of a story is placed in this way, it may be 
manually flowed by selecting further frames (or drawing them 
if necessary) and clicking on the story for each frame. 
Groups of frames may be selected in frame mode either by 

clicking on them individually while holding the shift key down, 
or by dragging with the mouse, starting with the pointer 
above and to the left of the frames, and dragging to the 
bottom right. A dotted box will be drawn and all frames 
completely within it will become active. Groups of frames can 
be moved, resized or deleted en bloc. Clicking outside the 
group will de-select the whole group. Individual frames within 
a group may be de-selected by clicking on them while 
holding down the shift key, just like selecting them. 

Paragraph Mode 
Paragraph mode is used to set the paragraph 
styles used for text. Paragraphs are the basic 
unit of text used in Pressworks. Figure 1.3 shows 
the Paragraph mode screen. The paragraph 

styles have names, such as Headline, Subhead and Body 
Text. Each style controls the font used for the paragraph, 
line spacing, margins, justification, space between para-
graphs and many other things. 
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There are several pre-defined paragraph styles. These can 
be modified if required, or new paragraph styles can be 
defined. This is all done from paragraph mode, though 
paragraph styles can also be defined in Text mode. 
Paragraph styles can be saved in document templates. This 
is another thing which helps maintain consistency of design 
over several documents. 

. 
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Figure  1.3 The Paragraph mode screen 

If you have imported a plain text file, or a file from a word 
processor where text features are not carried over, all 
paragraphs are initially imported as body text. One of the first 
things you will want to do is to go through the text in 
paragraph mode and give the paragraphs the required 
styles. This is often referred to as 'tagging' paragraphs. To 
do this, you simply place the text cursor anywhere within the 
paragraph and click, and then click on the required style in 
the browser. Paragraph styles are displayed in this during 
paragraph mode. 
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Text Mode 

Text mode is used for direct entry of text. Text 
must be placed in a frame. In text mode, when 
you select a frame by clicking in it. a text cursor 
will appear, and you can then start typing in text. 

You cannot select a frame which contains a graphic in this 
mode. Figure 1.4 shows the screen in Text mode. 
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Figure 1.4 The screen in Text mode 

If a frame is empty when selected, you can go on entering 
text until it cannot take any more. At this point, you will be 
warned that the frame is full. If you want to be able to flow 
the text to other frames, you have to name it as a story. It is 
then added to the browser, and can be treated just as an 
imported story. 

Editing of existing stories is also done from text mode. You 
may position the text cursor at any required point and add 
text, and also perform other editing operations such as 
deleting unwanted text, cutting and pasting text to new 
positions, and performing spelling checks. If you add 
substantial text to a story which flows between frames, you 
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should check that the story has not overflowed the last 

frame. 
Text mode is also used to make local changes to text style 

when editing stories. Any section of a paragraph, right down 

to single characters, can be given styles like bold, italic and 

underline, or even changed to a different typeface and/or 
size. 

Draw Mode 

Draw mode is used to draw simple graphics in 
frames. The facilities provided are considerably 
more limited than you would find in a graphics 
program, but are useful for decorative features 

such as boxes and vertical and horizontal rules, and for 

drawing simple figures. 
Directly drawn graphics can be added either to an empty 

frame, or to a frame which already contains a graphic or text. 
This is an exception to the usual rule that a frame can 
contain only one thing. To draw, you select the frame first, 
and then the drawing tool you wish to use. 
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Figure 1.5 The Draw mode screen 
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The drawing tools are displayed in the toolbar (the browser 
is hidden in Draw mode). The available tools include straight 
and freehand lines, polylines and rectangles, circles and 
ellipses. The closed items can be given a pattern fill. Chapter 
4 describes drawing graphic items in detail. Figure 1.5 shows 
the Draw mode screen. 
The Draw mode graphics are really only intended for 

decorative features, rather than for full illustrations. They are 
quite effective for this purpose, particularly for rules in text 
frames. Graphics drawn in this way, unlike directly added 
text, cannot be exported for use elsewhere. 
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2. MASTER PAGES AND TEMPLATES 

Though Pressworks is supplied with a wide range of sample 
templates, covering many possible uses, there will come a 
time when you will want to design a template of your own. 
This is not a difficult process, but it needs some forethought 
and probably some experimentation. Especially when you 
are at the base of the learning curve, it is unlikely that you 
will get a template exactly right first time. You should not 
worry about this. It is simply part of the learning process. 

Startup Options 

Blank Page__  Select Template_ I Default Temp ate  

— Open the selected Document 

c:‘.resswk\cint.w\chl.dt . 
c:\presswk\dtp‘fsu_setl.dtp 
cApresswk\dtpItmp_lab.dtp 
c:1presswk1dtp\bab_lab.dtp 
More Files... 

' 

mri •,.. 

— Hint 
You can choose how you want the program to 
start up by selecting Preferences horn the 

Help 
I 

Options menu. 

Figure 2.1 The Startup Options dialog 

Startup 

When you start Pressworks, by default it displays the Startup 
Options dialog (see Figure 2.1). From this, you can choose 
to open an existing document, or to start a new document, 

with an existing template (a selected one or the default), or 
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with a blank page. When you want to design a template from 

scratch, you click the Blank Page button. 
The Blank Page button produces the Page Format dialog, 

shown in Figure 2.2. This sets the size and orientation of the 
paper, and whether you will use one or two master pages, All 
Pages Alike or Left & Right. It is important that this is set 
correctly, as the settings you make here cannot be changed 
subsequently. If you change your mind about anything here, 
it is best to do it early in the design process, as it means 

starting from scratch. 

• Page Fonnat • 

'Paper Size 

Organizer: 3.75 z 6.50 in. 
Fungoid: 8.5 u 11 0 in. 
Fanfold: 8.5 sr 12.0 in. 
A3: 297 ic 420 mm 
A4: 210 it 297 rum 
A5: 148 ir 210 mm 
Custom Size 

Luslum 

entti. 

1:111 

I Oil 

- Language 

English (UK) 

OK .  

Cancel  

Help 

'Master Pages 

(Li) All Pages Alike 

0 Lett & Right 

Orientation 

0 Landscape 

(ii) Portrait 

Figure 2.2 The Page Format dialog 

Page Layout 

In the Page Format dialog (Figure 2.2), the first thing to set is 

the paper size and orientation. Various standard paper sizes 
are included in a list box, and it is also possible to enter a 
custom size. The paper size you are entering here is the size 
of the paper you will be using in your printer when printing 
the document. It may not be the same as the document 
page size if these are to be trimmed. The paper size must be 
one your printer can take, or you are likely to experience 
some problem, major or minor, when you come to print. It 
goes without saying that you must have this size in your 

printer when printing. 
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You can choose to have the paper in either landscape or 
portrait orientation. Landscape means width greater than 
height, portrait means height greater than width. If you are 
entering a custom size, the figures you enter must be correct 
for the orientation you have specified, (i.e. height greater 
than width for portrait) or Pressworks will transpose them. 
The Orientation setting takes precedence over the sizes you 
enter. For both dimensions, the size you enter must not be 
less than 1cm (0.39 inch) or greater than 57.15cm (22.5 
inches). 
You must choose at this stage whether to have all pages 

alike or left and right master pages. You will need to have 
left and right pages if different margins are required, either to 
allow extra width on the inner margins for binding, or for 
design purposes, or for a combination of these. Having all 
pages alike is an advantage if possible, as it simplifies 
adding single pages to the document. If you add a single 
page in the middle of a left and right' document, following 
pages will not automatically change, so right pages will be 
the left type, and vice versa. In such documents you must 
normally add pages in pairs. 
You also set the document language from this dialog. This 

sets the dictionary to be used for spelling checks. Press-
works is only supplied with the dictionary for one language 
(which may vary depending on where it is bought), but 
additional language packs are available from GST Customer 
Services. This sets the language for the overall document. 
However, different languages may be set for different 
paragraph styles. This facilitates the production of multilin-
gual documents. 

Click on OK when all the settings are as you want them. A 
blank page will then be displayed. Two further things should 
be done at this stage. Firstly, if you use more than one 
printer, you should choose the one you intend using for this 
document. Pressworks always uses the current default 
printer. Select Printer Setup from the File menu, and use the 
Print Setup dialog to make the required printer current. To 
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avoid problems, always make this printer the current one 
when working on documents based on this template. 
You should also select the units you wish to use when 

designing this document. You can choose from Picas and 
Points, Centimetres, Inches and Tenths and Inches and 
Eighths. The units you choose are used throughout Press-
works for specifying most dimensions, such as margins, 
spacings and frame sizes. However, font sizes and line 
spacings are always specified in points. 
(Note: A point is the typographer's unit of measure, 

approximately 1/72 inch. A Pica is 12 points, or approxi-
mately 1/6 inch). 

Column Guides 

Number of Columns: 

- Dimensions 
cm. 

Top Margin:14.50 

Bottom Margin: 

Left Margin: 

Right Margin: 

Gap Between Columns: 

18.80 

15.70 

15.70 

10.20 

E Print Position on Page 

Cancel   

 Help I 

Vertical Adjustment: 000 

Horizontal Adjustment: 0.00 

0 Up ®4 Down 

0 Left (*) Right 

Figure 2.3 The Column Guides dialog 

Column Guides 
Column Guides are faint dotted outlines which are normally 
displayed on each page of your document, though they can 
be hidden if required. Text is not forced to follow these 
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guides. This is done with frames. However, the column 
guides are used as visual guides when drawing the frames, 

which can be made to 'snap' to them, rather like in drawing 
programs. 
The area of the page covered by the guides is that within 

the page margins, top and bottom as well as sides. If you are 

using different left and right pages, margins and guides can 
be set separately for the two pages. To do this, you must 
move to the appropriate master page. Select Go to Page in 
the Page menu to produce the Go to Page dialog, and then 

click on the Left Master or Right Master button as required. If 
your document has all pages alike, there will only be one 

Master button. To set up the margins and guides, choose 

Column Guides from the Page menu to produce the Column 

Guides dialog, shown in Figure 2.3. 

Margins 

The top, bottom, left and right margins can be set 
individually, and for left and right pages where appropriate. 
These margins do not limit the area of the page where you 
can place text and graphics, and in fact it is normal for 

headers and footers to be placed outside them. Rather, they 
set the area in which you will normally want the main body of 

text and illustrations to be placed. The column guides will fill 
this area. 

You can choose to have from one to nine column guides. 
The value you set here will not necessarily be the number of 
text columns you normally want to use. You may want to 
have more columns than this so that they can be used as 

more general-purpose guides when drawing frames. For 
example. with the default template, there are six column 
guides. You can use these to draw one very wide column, 
two comfortable columns, three narrow columns or six 
untenable columns. This book uses a single text column, but 
four column guides, to allow for drawing illustration frames of 
less than the full column width. 

If you are designing a template for a free-form document, 

you may wish to have narrow margins, and to have a 
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relatively large number of column guides, perhaps eight or 
nine, covering most of the page area. 
The gap between the columns can also be set. This gap 

will be the same between all pairs of columns. The width of 
the column guides cannot be set directly. Pressworks 
calculates it from the available space between left and right 
margins, the gap between columns, and the number of 
columns. Pressworks will protest if it finds you have entered 
irrational values. 

Frames 
If you draw frames on the master page or pages, these 
frames will be included on each page you add to the 
document, whether this happens automatically (when placing 
a story with autoflow) or manually. Normally, the frames 
drawn on the master pages should be for the ones you want 
to use for the main body of text, and should set the column 
layout you require. 
When you autoflow text, if the whole story will not fit on the 

page, extra pages will be added until it is all placed. These 
pages will have the frames drawn on the master page(s). If 
there are no frames on the master pages, the frames will be 
copied from the first page on which the story is placed. Only 
frames containing the story will be copied. Empty frames or 
frames containing other things, such as graphics, will be 
ignored. 
As autoflowed text will tend to occupy all empty frames on 

pages derived from the master page, it follows that it is 
difficult to place frames on the master pages for graphics, 
where the graphic will be different for each page. This may 
be a rare requirement, but someone is bound to want to do 
it. The trick here is to draw the frame, and to draw some sort 
of graphic in it, which can be as simple as a single line. 
Autoflow will then ignore these frames. You can then remove 
the 'blocking' graphic and add the required illustration page 
by page. Frames can be cleared of their contents by 
selecting them and choosing Clear from the Edit menu. They 
can then be given new contents in the normal way. 
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Fixed Text and Graphics 
There will be cases where you want to place the same text 
and/or graphics on every page of a document. The text may 
be a title, chapter name or section heading. Graphics may be 
something like a company logo, or decorative features like 
vertical or horizontal rules. 

Basically, anything you place on a master page will be 
copied on each new page added to the document, so to add 

fixed text or graphics, you draw a frame on the appropriate 
master page, and add the text or picture. 
Fixed graphics on a master page can be either drawn in 

Draw mode, or imported. However, fixed text must be added 
from Text mode. It is not permissible to place an imported 
story on a master page, even if it fits into a single frame. 
Rules are probably the most common type of graphic to be 

placed on the master pages. They are simple lines used to 
divide the page up visually. Horizontal rules can be used in 

book-type layouts to separate the headers and footers from 
the body text. This is useful where extensive headers and 
footers are used. Examples of this are where the header 
includes the page number and the current topic, and the 
footer contains the chapter name and number. Horizontal 
rules are also placed sometimes at the end of a chapter. 
Vertical rules can be used to divide columns. This is most 

commonly done in newspaper-type layouts, where gaps 
between columns are kept narrow to allow the maximum 
amount of text on a page. Inter-column rules aid readability. 

In book and magazine layouts, it is more normal to allow 
more space between columns. Rules between columns are 
most desirable where gaps (or 'gutters') are narrow and right 
margins are unjustified (or ' ragged'). 

Headers and Footers 

While headers and footers can be added to a document or 
modified at any time, if they are required on every page it is 

most convenient to make them part of the template, by 
defining them on the master pages. Again, this will also 
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ensure consistency when using a template for a number of 

documents. 
Headers and footers are single lines of text placed at the 

top and bottom of each page of a document. You can have 
header only, footer only, or both. When you have left and 
right master pages, headers and footers are individually 
definable for both pages. They are defined from the Headers 
and Footers dialog, from the Page menu, shown in Figure 

2.4. 

Headers It Footers 

—Header 
Left: 

Centre: 

Right: 

A Concise Introduction Lo Presswork:I 

Distance From Top of Page: 1.25 cm. 

Looter 
Left: 

Centre: 

Hight: 

tu 

Distance From Bottom of Page: 8.20 cm. 

Rise It For Page Numbers. Z For Last Page] 

OK I 

Cancel 

Clear All  

Figure 2.4 The Headers & Footers dialog 

Each header or footer can have three parts, left aligned, 
centred, and right aligned. You do not have to enter text for 
all six positions, only those you want. The left and right 
alignment is with the left and right margins specified in the 
page layout. If you want to have the header or footer 
extending horizontally beyond the area used for the main 
text, you must set the margins for the required header or 
footer position, and limit the text position by not drawing 
frames to the full column guide area. 

The vertical positions of the header and footer are set 
relative to the page, not the margins. This means that they 
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can easily be placed outside the column guides area 
vertically, and in fact it is normal to do this. 
To define the text for the sections, you simply type it into 

the appropriate box in the dialog. It is your responsibility to 
make sure the text you enter is not too long to fit into the 
available width on the page. 
When you add headers or footers to a page, paragraph 

styles called Header and Footer are created and added to 
the browser. If you are using left and right master pages, 
four styles (L Head, R Head, L Foot, R Foot) are created. 
These start off with the Body Text characteristics, but can be 

selected and edited in the normal way, as described in 
Chapter 3. 
Any of the three sections can be used to display running 

page numbers. This is done by including the hash or 

American pound symbol (#) in the text, or using it alone. For 
example, 'Page #' will print as 'Page 21' on page 21. You 
can also use the per cent symbol (°/0), which is substituted 
by the total number of pages in the document. For example, 

'Page # of `Yo' will print as 'Page 6 of 36' on page six of a 36 
page document. 
The ability to define separate headers and footers for left 

and right pages is useful when adding page numbers. For a 
reader searching for a particular page, it is a lot easier if the 
page numbers are printed towards the outer edges of the 
pages. That is, to the left on left pages and to the right on 
right pages. The larger the page size, the more important 
this is. When you are using left and right master pages, the 

dialog includes a Select group box. From here, you control 
whether you are defining headers and footers for left pages, 
right pages, or both. This latter makes it easy to define 
identical headers and footers for all pages. 
When you want to define different headers and footers for 

left and right pages, you must select one page (left or right), 
enter the required text, and then click on OK. This closes the 
dialog. You must then produce the dialog again, enter the 

text for the other page, and click OK again. 
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When producing a long document in sections (for example, 
a book in chapters), you will not want the page numbers to 
start from 1 for every section. You can set the starting page 
number from the Page Numbers dialog, which is on the Page 
menu, shown in Figure 2.5. You can also set the format to 
be used for the numbers. This can be the normal Arabic 
(1,2,3 etc.), Roman in upper or lower case ( 1,11, or i,ii) or 
alphabetical in upper or lower case (A,B or a,b). This format 
is used for both the page number and the last page number. 
It is normal to use Arabic for the main bulk of a document. 
Few people can understand Roman numerals past XX. 
These should be reserved for the ends' of books, such as 
multi-page forewords or prefaces, or for long indexes. 

- Pagç.ihiumbers-

Start Numbering From:1 

- Format 

19 

(.*.) L2...999 

0 

0 b... ¿z 

OK 1 

Cancei I 

Help 

Figure 2.5 The Page Numbers dialog 

Automatic page numbers can only be added to documents 
in headers and footers. If you need page numbers anywhere 
else, it will be necessary to add them manually. 
When working on a document, you can turn headers on or 

off for any page by selecting or deselecting Header on This 
Page or Footer on This Page on the Page menu. This will 

only affect the page you are currently working on, which 
means the page currently displayed, or the page with the 

currently active frame if you are displaying two pages. The 
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number of the active page is always displayed at the bottom 
of the screen. 

Templates 

The settings you make on the master pages are used for all 
pages added to your document. They can also be saved and 
used as a basis for other documents to avoid having to make 
all these settings again. This saves a great deal of time. 
When you save a template. as well as the master page 

settings, you also save all paragraph definitions. Again, this 

saves a lot of time, as paragraph definitions can include a 

great deal of information, and are at least as important as 
the master page layouts in maintaining consistency between 
documents. It is therefore a good idea to make all required 
paragraph definitions before saving the template. Defining 

paragraphs is described in Chapter 3. 
Templates are saved from the Save Template dialog, from 

the File menu, shown in Figure 2.6. You do not have to 
provide a file name for the template. Instead. you choose a 
category from the Category list box, or provide a name for a 
new category, and then provide a name for the template, or 
choose one you wish to overwrite, in the Template list box. 
Pressworks will generate a file name from these names. 

Save Template 

FLategory 
I Book 

  E Include Pages 

r Template 
I Babani_cic LJ 
N oies 

' Mastei 

Mattel and First 

.1% All 

Make default 

I Template for 1:1 CRII 

OK 

Cancel 

Help 

li 
Figure 2.6 The Save Template dialog 
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When you save the template. you can choose to save the 
master page(s) only, the master and first page. or all pages. 
Saving the master pages only is appropriate for documents 
where all pages including the first will use the same basic 
layout. The master pages only provide default layouts when 

adding pages. It is always possible to make major or minor 
changes on a page-by-page basis. 
There are many occasions where it is required to have a 

first page with a different layout to the rest. This may be for a 
cover for a multi-page newsletter or magazine, or for the first 

page of book chapters, which often carries a large heading, 

less text than normal pages, and often no header. if one is 
defined. To avoid having to make these changes to the first 
page, it can be included in the template. 
For some publications, like magazines perhaps, you may 

want to use quite different layouts on every page, but be 
consistent in overall layout from issue to issue. In such 

cases, the master page layout may not be of much 

significance. For these cases, it is possible to save all the 
pages in the template. Such a case does still have master 

pages, and these will be used if any pages are added, but 
you may choose to leave them blank. 
When saving pages with the template, any fixed text, and 

all illustrations will be saved. However, imported stories 
cannot be saved with the template in any circumstances. 
When saving the first pages or all pages, it is important to 
check that only the required permanent elements are 
included. If anything else is left in, you will have to go 
through and remove it each time you base a document on 

the template. 
Clicking on OK in the Save Template dialog will save the 

new template. It will be placed in the directory you have 

specified for templates in the Preferences dialog. It will be 

available to you whenever you start a new document. If you 
want to make it the default template, check the Make Default 
check box in the Save Template dialog before saving. It is 

suggested you do not do this until you have some 

30 



experience with the program, as the supplied default 
template is good for quick trials and experiments. 

Modifying a Template 
A template design can be modified at any time. If you add 
new paragraph styles, for example, you can add these to the 
template by selecting Save Template from the File menu. 
You must select the category and name of the template in 
the appropriate list boxes, and also add a description if 
required, otherwise any old one will be lost. You will be 
asked to confirm that you want to overwrite the existing 
template. 
You can also use this procedure to make any changes you 

have made on the master page(s) or other included pages 
permanent. Note that changes made in this way will not 
affect any other documents already based on this template, 
only new ones created with it. 
To make a new version of the template without changing 

the original, display the Save Template dialog, enter a new 
template category or name, and save. You will then have two 
identical templates with different names. You can then make 
any required changes, and use the Save Template dialog to 
save them, as described above. This avoids any possibility 
of overwriting the original, and is a standard computing 
procedure. 

It may be that you design a one-off document and decide 
there is no point in saving the template. If at some stage you 
decide that you do after all want to base further documents 
on this design, all is not lost, provided you have the 
document file on disk. It is simply a matter of opening the 
document, and choosing Save Template from the File menu. 
The ability to save the template at any time, and the 

options to include various pages, makes the Pressworks 
template system one of the most flexible and versatile you 
will find in the DTP world. It is worth careful consideration of 
how you can use it, as it really can save you a great deal of 
time. 
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3. TEXT 

Text is usually the most important part of a DTP document. 
There are two broad ways in which it can be incorporated. It 
can be directly entered from within Pressworks, or it can be 
prepared in a word processor or text editor, and imported. 
Which of these you choose will mainly depend on the length 
of the text. Though Pressworks has word-processing fea-
tures, these are less extensive than a full word processor 
provides, and the page-orientated display is less convenient 
for preparing long documents than a word processor's 
scrolling display. 

Direct Text Entry 
To enter text directly into a Pressworks document, you must 
be in Text mode, and there must be a frame available (which 
usually means empty) to take the text. Normally, you would 
draw at least one frame from Frame mode before entering 
Text mode, but it is worth noting here that Pressworks has a 
feature where temporary access to frame mode can be 
obtained by holding down the right mouse button. If you hold 
down this button, you can draw frames in any mode, using 
the left button as normal. 
Text directly typed in will by default take the Body Text 

paragraph style. (Every document must have a Body Text 
paragraph style). It is possible, however, to choose another 
style from those defined, and add the text in this style. When 
in text mode, the current paragraph style is displayed in a 
drop-down list box to the right of the toolbar. Any available 
style can be chosen from this. 

Alternatively, all the text can be added in Body Text style, 
and the style of paragraphs changed later. This can be 
preferable if you are a touch-typist and adding a great deal of 
text. The program will normally 'keep up' with the typing 
better in this style than in more elaborate ones. With this 
method, paragraph styles must be changed from Paragraph 
mode. 
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There is, of course, a limit to the amount of text a frame 
will take. When you reach this limit, the program will not 
allow you to enter more. You will be presented with the 
Frame Full dialog (see Figure 3.1), from which you can give 
the text you are entering a name. If you name the text, it 
becomes a story and the name is added to the browser. You 
can then flow the story between frames. If the Autoflow 
check box in this dialog is checked, the story will flow 
automatically, with extra pages being added if necessary. 
You must uncheck this box if you want to add more frames 
on the current page manually. 

The current Irame has no room for more text. 

You can choose to name the text (turn it 
into a story), and optionally autoflow it 
onto new pages. 

'Name For New Story 

Autoflow 

Cancel  

Figure 3.1 The Frame Full dialog 

If you do not autoflow the story, you must manually select 
the new frames to take it, drawing them if necessary. To flow 
the story into the frame, you click in the frame, and then click 
the story in the browser. You will then be able to add text in 
the new frame. 

If you have typed in a story spreading over several frames, 
and you are editing it, be careful when deleting text. You 
may find if you delete back from one frame to a previous 
one, the frame disappears. This has happened to the Author 
a couple of times for no apparent reason. This is probably a 
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bug, but the Author has a very early release, and it may be 
cured in later copies. 
For documents with long passages of text too big to fit in 

one frame, it is always a good idea to flow text between 
frames. This simplifies editing, and also restyling of the 
document if this involves changing the size of text frames, or 
drawing frames for pictures over them, both of which 
displace text. If, as a result of these actions, the text is too 
big to fit in the available frames, the fact that there is 
overflow is indicated by the bottom of the last frame being 
dotted. You should always check this point after editing a 
story of any type. Figure 3.2 shows the dotted bottom of a 
frame which is overflowing. 

Note that when select multiple paragraphs, they must all be 
pn the same page. You cannot select a group of paragraphs 
peross pages. 

Oeleting a Style 
It is possible to delete an unwanted paragraph style from the 
list in the browser. The exception to this is Body Text. You 
rnust always have a style of this name. To delete a style in 
Paragraph mode, highlight its name in the browser, either by 
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Figure 3.2 The dotted bottom of a full frame 

Where there are only small amounts of text in a document, 
such as in posters and notices, flowing between frames may 
have no advantage. It will often be easier to place each line 
in a separate frame, especially where large size type is used. 
This makes it easier to put line breaks where you want them, 
and to move the frames around to experiment with different 
layouts. If you make the text flow, changes of frame size 
may make words jump from frame to frame, which may be 
undesirable. It can also be hard to make them jump back 
again. 
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If you enter large amounts of text into a document, you 
may want to be able to save that text to file, other than as 
part of the document, so you can use it with another 
program. To do this, you must first name the text as a story. 
This may have happened already if necessary to flow the 
text between frames. If not, the text is named by selecting 
Name Text from the Text menu. This produces a dialog in 
which you give the text a name. The name must follow file 
name rules, which means it must be not more than eight 
characters. The extension . txt is added automatically. Note 
that the text is not saved to disk at this stage. Figure 3.3 
shows this dialog. 

Figure 3.3 The Name Text dialog 

Stories are exported from Frame mode. You must either 
click on the frame (or a frame) containing the story, or on the 
story name in the browser. Selecting Export Text from the 
File menu will produce the Export Text dialog. This is a 
standard Windows file save dialog, from which you can set 
the path to save the text, and, if required, give a file name 
other than the story name. Figure 3.4 shows this dialog. 
Three formats are possible for saving the text. Rich Text 

Format (RTF) is the most sophisticated of these. If you use 
this, paragraph styles and other formatting information will be 
included in the file. You can read the file into a word 
processor or other program which supports this format, and 
styles will be preserved. RTF is supported by a number of 
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word processors, including several popular Windows-based 
ones. These do, however, differ in the features of the RTF 
format they support. Information on this for various word 
processors may be found in the README file supplied with 
Pressworks. 

Figure 3.4 The Export Text dialog 

If it is not required to preserve formatting, there are two 
'plain text' formats available, ASCII and DOS Text. ASCII 
should be used if you intend using the file with Windows-
based text editors or word processors. This will ensure that 
the correct character set is used, as far as possible. The 
DOS character set is different. Saving as DOS text will not 
convert characters (this may not be possible), but it will 
minimise problems. A DOS text file can be copied direct to a 
printer using the COPY command from DOS. 

Importing Text 
It is normally much more convenient to write large amounts 
of text using a word processor. The 'scrolling' display is more 
convenient than having to add frames periodically, and 
usually the text can be displayed in a convenient size while 
adding and editing text. 
When a file is imported into Pressworks, it is interpreted 

and converted into the internal format used by Pressworks, 
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and a copy of the text is stored in the DTP document. The 
word processor file remains on disk, and is not altered in any 

way during importation or during editing of the text within 
Pressworks. It follows that any editing done on the word 
processor document subsequently is not automatically re-
flected in the DTP document. After importation, you have two 
copies and if you want to keep these in line, you have to 
make subsequent changes to both. 

Files are imported by choosing Import Text from the File 
menu. This produces the Import Text dialog, a standard 
Windows file dialog, which is shown in Figure 3.5. 

Figure 3.5 The Import Text dialog 

Word processors normally now allow a great deal of text 

formatting. This is especially true of Windows word proces-
sors, which come close to DTP facilities, including paragraph 
styles and the inclusion of illustrations in documents. (Files 
with included illustrations cannot be imported into Press-
works). It is a question of deciding how much of the 
formatting should be done in the word processor, and how 
much subsequently, after the text has been imported into 
Pressworks. 

Formatting can be conveniently divided into three areas. 
These are page layout, paragraph styles, and local styles. 
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Page Layout 
Page layout concerns the settings of margins and columns, 
and also headers and footers. If an imported file contains this 
information, Pressworks will not use it. The page layout 
designed in Pressworks will be used, and the paragraphs will 
be reformatted to fit the frames used for the text. Headers 
and footers in the file are discarded. These things are 
necessary, as a Pressworks document may include several 
text files which may have different layouts. 

Paragraph Styles 
Paragraph styles are used to set the font (typeface, size and 
style), spacing of lines, indents, and space above and below 
paragraphs. In general, paragraph styles are preserved in 
files imported into Pressworks in compatible file formats. 
'Compatible' in this case means the Microsoft Word native 
format (.doc) and the Rich Text Format (. rtf). 
With Windows-based word processors, the fonts available 

to the word processor will be the same as those available to 
Pressworks, which makes things straightforward (assuming 
the same machine is being used). With DOS programs, 
some fonts may be the same (e.g. those built in to the 
printer) but others may be different. There may be different 
fonts used in a Windows-based document if it has been 
prepared on a different machine. In these cases, Windows 
will match fonts as best as possible from the information 
about the font in the file. 
Spacing of lines and indents will be preserved with most 

file formats. In word processors, line spacing will often be set 
in terms of lines (i.e. single- line spacing, double-line spac-
ing), though the best allow fractional settings. Pressworks 
sets line spacing in terms of points (in typography it is called 
'leading', derived from, and pronounced like, the name of the 
metal). This is a finer setting than normally possible with 
word processors. The spacing will therefore be translated 
accurately, but you may find you can improve the appear-
ance of text by making adjustments after importing. 

39 



When you import a compatible file incorporating paragraph 
styles, these styles will be added to the browser. You can 
then tag paragraphs with these styles, be they in other 
imported files, or directly entered. It is possible to delete 
paragraph styles from the browser (from Delete Paragraph 
Style in the Text menu). If you do this, any paragraphs 
tagged with that style will be changed to the Body Text style 
(Body Text style is mandatory and cannot be deleted). 

If you have paragraph styles with the same name in the 
text you are importing and in the DTP document, the DTP 
document style will take precedence. The imported para-
graphs will be changed to this style as they are imported. 

Local Styling 
Local styling of text is where some text within a paragraph is 
changed to a different style, such as bold, italic or underline. 
Some word processors may also allow local changes of 
typeface and/or size. Change of typeface is very useful for 
including symbols within text. These local changes are 
interpreted well by Pressworks when importing Microsoft 
Word .doc files, and when importing stf files. However, 
Pressworks can only, of course, preserve features if the 
word processor saves them in the file. Not all word 
processors which use the RTF format use all the features it 
offers. 
The situation with DOS word processors is different, even 

where these support RTF. Bold, italic and underlined text 
may be preserved, but font changes may either not copy 
over, or the font or characters used may not be correct. It is 
advisable to do tests with the features you want to use, to 
see exactly what happens on importation. 
Some word processors do not support paragraph styles, 

but do allow local styling of text. These include the Windows 
Write word processor 'bundled' with Windows, and WordPer-
fect 4.n and 5.n. When files from these are imported, all 
paragraphs will have the Body Text style, but (depending on 
compatibility) the local styling will be preserved. You may 
want to design paragraph styles with these characteristics 
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within Pressworks, and to change the paragraphs to these 
styles. If you then make a change to one of the styles, it will 
be applied to all paragraphs with that style hame automati-
cally. If you rely on the local styling, you will need to change 
them all individually. 

It is not possible to give details of compatibility with the 
various word processors, as (in Windows generally) conver-
sion of file formats is normally done by means of modules 
external to the main program, called 'filters'. These can be 
changed and added to by the software house, without a 
change of release version. Such details could therefore 
become out of date rapidly, and versions listed as not 
available could well become available with later copies. 

Tagging Files 

The term 'tagging' has two different, but closely related, 
meanings in DTP. It can mean going through text, and 
assigning styles to paragraphs, or it can mean including code 
sequences in a text file, indicating paragraph styles and 

other text features. These codes are used to assign styles as 
the file is imported. Writing such a file needs more work than 
writing an equivalent file with a compatible word processor, 
but is useful if your word processor is not compatible. 
Tagged text files can be written with any word processor 

which can save a plain text file (and virtually all can - the 
term 'non-document mode' is sometimes used for this), and 
also with simple text editors, like the Windows Notepad, or 
the MS-DOS Edit utility. The tags themselves consist only of 
characters which can be typed from the keyboard, and there 

should be no problems with different character sets. The 
tags you add are known as the 'markup language'. 

The Markup Language 

The markup language consists of tags to set paragraph 
styles, to toggle text features on and off, to change 
justification, and even to define new paragraph styles. Each 
tag consists of one or more characters between the 'greater 
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than' and 'less than' symbols, < and >, also known as 'angle 
brackets' 

Paragraph Style Tags 

The tag for a paragraph style consists of a dollar sign, 
followed by the name of the paragraph style, within the angle 
brackets. The paragraph tag must appear at the very 
beginning of the paragraph, which means it must be the first 

thing on a line, and, except at the very beginning of a file, it 
must be preceded by a carriage return (i.e. the end of the 

previous paragraph). 
Spaces before the dollar sign, or between the dollar sign 

and the style name, are ignored. The style name can be a 
maximum of 10 characters, and may include any characters 
apart from control codes and commas, including spaces. 
Spaces between the end of the name and the closing 
bracket are discarded. Upper and lower case characters are 
treated as the same. 
The paragraph style will apply to all text between the tag 

and the next carriage return. To give several paragraphs in 
succession the same style, each must be tagged. There is 

an exception to this. Any paragraph with no tag is given the 
Body Text style. This is a time-saver, as it means the bulk of 
the text, in most cases, does not require to be tagged. 
As text is imported, the tagged paragraphs will be given 

the style defined for the name given. If no style of this name 
has been defined, the name will be added to the browser, 
and initially given the Body Text attributes. If you subse-
quently edit the style, all paragraphs tagged with this name 
will change to the new attributes. 
The following are some examples of legal paragraph tags. 

<$headi ngl> 

< $ headingl > 

‹$2nd Indent> 

<$ Caption> 
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The following are examples of illegal paragraph tags. 

<headi ngl> (forgot the dollar sign) 

<$head, typel> (includes a comma) 

<$subsubsubhead> (too many characters) 

Text Alignment 
The default alignment (justification) of a paragraph style can 
be overridden by using the following tags. They should be 
placed after the paragraph style tag. The tag only affects the 
paragraph in which it is placed. 

Code Effect 

<CJ> Justified (left and right) 

<CL> Flush left (ragged right) 

<CR> Flush right (ragged left) 

<CC> Centred (ragged left and right) 

Typeface 
The typeface for a font is set by placing the name of the font 
after an upper-case F in the brackets. As with paragraph 
tags, spaces before and after the letter F, and after the font 
name, are ignored. Spaces are allowed within the font name, 
so you can specify fonts like Times New Roman and Lucida 
Sans. A capital F in the angle brackets by itself will cause a 
return to the default typeface for the current paragraph style. 
For example, 

This is <Fsymbol > Symbol < F> Typeface 

will print as 

This is DI/ 40),. Typeface 

If you do not switch back to the font for the paragraph style 
in this way, the new one will continue to the end of the 
paragraph. 
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If a facename is specified which does not exist on the 
machine on which Pressworks is installed, another will be 
substituted. Frankly, which you get is a bit of a lottery, but, 
for a standard Windows installation, it is likely to be Anal or 
Times New Roman. 

Point Size 
A change of point size can be effected by using an 
upper-case P, followed by the required point size. The 
possible range is 3 to 250, and integer values only can be 
given (i.e. no fractional point sizes). Similarly to the 
facename, a P alone in the brackets will revert to the 
paragraph default size, and spaces are similarly ignored. 
For example 

Small Text <P20>Large Text <P>Smal 1 Text 

will print as 

Small Text Large Text Small Text 

The width of text can be set using an upper-case E 
followed by the compression ratio (actually percentage of 
normal width) in the brackets. For example, <E150> will give 
150% of normal width, and <E 25> will give one-quarter of 
normal width. The possible range is 25% to 200%. Less than 
about 70% width tends to be unreadable, even in large sizes. 

This is 200% 
Cntury Gothic 

This is 75% Book Antigua. 

The success of altering the width of characters depends on 
the nature of the fonts you are using. If you are using 
scalable outline fonts, such as TrueType or PostScript (with 
Adobe Type Manager), the results can be very satisfactory. 
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If you are still using non-scalable bitmap fonts. the results 

are likely to be somewhere between ropey and atrocious. 
Stretching generally looks better than compressing. 

Text Styles 

Text styles include such things as bold, italic, underline, and 
combinations of these. These are turned on and off by tags 

which act as toggles. The first time the code is encountered, 
it turns the effect on. The second time, it turns it off again. 

Note, however, that the effect will not be carried over from 
one paragraph to another. If you want the whole of several 
successive paragraphs to be in, for example, bold, you must 
put the tag at the start of each paragraph. 
The following are the tags available. 

Code Style controlled 

<B> Bold 

<I> Italic 

<N> Normal (reset all styles to default) 

<0> Box 

<R> Rounded Box 

<S> Strikethrough 

<U> Underline (like this) 

<u> Underline Words (like this) 

<H> Double Underline (like this) 

<h> Double Underline Words (like this) 

<v> Subscript 

<A> Superscript 

<X> Plain text (turns off all styles) 

Styles can be combined within the brackets. For example, 
<BI> will toggle both bold and italic. Remember that the 

action of toggles always depends on what is already in 
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effect. If you use that tag when bold text style is already 
turned on, it will turn bold off and italic on. 

It is generally not a good idea to use these tags if you are 
using a compatible file format and styling the text in the word 
processor. This can be done, provided you keep the two 
separate, but if you put styled text between tags or tags 
within styled text, the effect is unlikely to be as intended. The 
Author prefers to keep the two entirely separate, either plain 
text with tags, or styled text and no tags. 

New Paragraph Style 
It is possible to define, in part, a new paragraph style within 
a tag. You can set the font (typeface and size) and text style. 
This is done by using a tag which starts with the # symbol 
rather than the dollar sign. This is followed by thé name for 
the style, following the rules above. After this comes a 
comma, followed by a series of tag style codes. You can use 
as many of these codes as required to define the special 
aspects of the style. Anything you do not specify will be 
copied from the Body Text style. The following is an 
example. 

<#Fancy, FSage, P16, CC> 

This creates a new paragraph style 

which looks like this. 

Problems can arise if you want to import a text file which 
includes angle brackets other than surrounding tags. Press-
works will attempt to interpret anything in angle brackets as 
tags. If it cannot interpret the tag, it will be treated as straight 
text. However, the angle brackets may be lost. The answer 
is to double the angle brackets, for example, include «» in 
the text to print as <>. This is also how the sample tags were 
incorporated in this original text file. You can use brackets 
initially as you want them to appear, and then use Search 
and Replace in your editor or word processor to double the 
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brackets. If this proves to be unnecessary, you can use 
Search and Replace in Pressworks to remove the extras. 

Figures 3.6 and 3.7 show what can be done with tags in a 
plain text file. Figure 3.6 is a screen shot of the text editor, 
showing the text file with tags. Figure 3.7 is the file after 
importation, without any editing. Note that although this is 
boxed as a figure, it is in fact a normal part of the text of this 

document. 
Note the blank lines between paragraphs in Figure 3.6. In 

a plain text file, single occurences of the carriage return 

character (or carriage return/line feed pair) can simply be the 
end of a line. You need to press the Enter key twice to be 
sure the end of the paragraph will be recognised. 

After Importation 

Whether you have imported a compatible file format with 
formatting, a tagged file, or a plain text file, it is likely you will 

want to make some alterations after it is in the Pressworks 
document. You can alter the style of some or all paragraphs 

or alter the style of parts of the text. 
To alter a paragraph from its current style to a style which 

already exists, you must be in paragraph mode. The actions 
necessary to make the change are slightly counter-intuitive, 
but you will soon get used to it. Firstly, you must click with 
the cursor anywhere in the paragraph. Its current style will 

then be highlighted in the browser, and the paragraph will be 

highlighted. You then click the style you want to change to in 
the browser. The paragraph style will change immediately, 
but it will remain highlighted until you click in another 

paragraph or change mode. 
When working on a plain text file, you will often want to 

change several paragraphs to the same style. You can do 

this in one operation. Hold down the control key, and click in 
each paragraph you want to change. For contiguous 

paragraphs, you can click in the first, hold down the shift key, 
and click in the last. All between will be highlighted. You can 
also drag through the required paragraphs. The current style 
will be highlighted in the browser, unless some of the 

47 



Elle Edit search View }risen Help 

a n um' tur_e r i• Li :.::•.::  

<11-leading 1>DEMONSTRATION * 

<SNormal>This is a demonstration of what can be done 
with a plain ASCII text file. This text editor cannot 
transfer styles to Pressworks by any other means. 

<SHeading 2>Text Styes 

<$Normal>It is possible to switd- Lu <S>buld, <I>bold 
italic, <6>italic ony, <U>italic underlined, < N> and 
back '10 normal. 

aNew Type, FTimes New Roman, P12, E125, CL> 

<New Type4his paragraph style uses the Times New 
Roman font at 125% w,dth, and is left- justified. This 1 
¡Ropy. ..  -•::: . :: . :: . ::Frc----Ricr---

Figure 3.6 A tagged text file in the editor 

DEMONSTRATION 
This is a demonstration of what can be done with a 

plain ASCII text file. This text editor cannot transfer 
styles to Pressworks by any other means. 

Text Styles 

It is possible to switch to bold, bold italic, italic only, 

italic underlined,  and back to normal. 

This paragraph style uses the Times New 
Roman font at 125% width, and is 
left-justified. This style is defined here 
and is not used elsewhere in the 
document. 

Figure 3.7 The imported text 
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paragraphs have different styles, in which case no style will 
be highlighted. 
When you have chosen all the required paragraphs, you 

click on the new style in the browser, and all will be changed 
to this style. Any already in the new style will not be affected. 
Note that when you select multiple paragraphs, they must all 
be on the same page. You cannot select a group of 
paragraphs across pages. 

Deleting a Style 
It is possible to delete an unwanted paragraph style from the 
list in the browser. The exception to this is Body Text. You 
must always have a style of this name. To delete a style in 
Paragraph mode, highlight its name in the browser, either by 
clicking the name in the browser, or by clicking a paragraph 
which has that style. You may also use the second method 
from Text mode. Then select Delete Paragraph Style from 
the Text menu. A message box will be displayed asking you 
to confirm your decision. Clicking on Yes will delete the style. 
All paragraphs with this style will revert to Body Text style. 
You can then change any of these paragraphs to another 
style, if required, as described above. 
As stated earlier, if you import a file in a compatible format 

which includes paragraph styles, these will be added to the 
browser. You may want to delete any of these if they 
duplicate styles under other names. For example, Microsoft 
Word insists on a paragraph style called 'Normal' in every 
document. Often, you will want this to be the same as Body 
Text. To achieve this, you simply have to delete 'Normal' 
after importation. 
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4. GRAPHICS 

There are two basic types of graphic which can be used in 
Pressworks, but these need to be discussed under four 
headings. The two groups are line art and bitmaps. Line art 
can be drawn using facilities in Pressworks or imported from 
suitable drawing/design projrams. These include CAD/ 
technical drawing programs and the more artistic line art 
programs, such as Designworks. Bitmaps come from 'paint' 
type art programs, such as Windows Paint, and also from 
scanners. Though scanner graphics share file formats with 
painted bitmaps, they need some special treatment. This is 
especially true of scans 'dithered' to simulate grey scales. 
Some art/design programs will cross these boundaries. For 

instance, the more advanced drawing programs, like Design-
works, can save drawings in either line art or bitmap form. 

Drawing Line Art 
The line-art facilities within Pressworks are limited, but can 
be quite useful for simple graphics or for decorative features 
on a page. In Timeworks, it was only possible to draw 
graphics in an empty frame, and once it contained a drawing, 
text could not be added. A big advance in Pressworks is that 
the drawing tools can now be used in frames which already 
contain text or drawings. This means that the drawing tools 
can be used for such things as rules (horizontal lines) 
between paragraphs, or boxes around graphics such as 
bitmaps. 
The available drawing tools are limited to straight lines, 

freehand lines, polylines, rectangles, circles and ellipses. 
Rectangles are available with square or rounded corners. 
As usual with any type of drawing program or facility, there 

is a grid. The grid acts as a guide when drawing. When you 
are in graphics mode, and a frame is active (by clicking in it), 
the grid will appear as a regular pattern of dots. You can use 
these by eye as a guide, or force the cursor to snap to them, 
by selecting Snap to Grid from the Draw menu. When this is 
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checked, Snap is on. You may turn Snap on or off as often 
as you wish while drawing. It will not affect anything you 
have already drawn in any way. 

If you find the grid distracting, you can turn it off, also from 
the Draw menu, by deselecting Show Grid. Like Snap to 
Grid, this is checked when active. The spacing of the dots on 
the grid depends on the current unit. If you want a coarser or 
finer grid, you may be able to achieve this by selecting a 
different unit, by choosing Units on the Options menu, or, if 
you have the rulers displayed, by clicking on the unit 
indicator where they intersect. 

Straight Lines are drawn by selecting the 
straight line tool, moving the pointer to one end, 
then holding down the left button and dragging to 
the other end. A dotted guide or 'rubberband' line 
is drawn as you move the mouse. When you 

release the button, the line is drawn. 

Free-hand Lines are drawn by selecting the 
free-hand line tool, moving the pointer to where 
you want to start the line, then holding down the 
left button, and moving the mouse in the path 
required. A free-hand line is, in fact, drawn as a 

series of short straight lines. Each of these takes up some 
memory, and because of this the number you can have in 
one free-hand line is limited. If you exceed this limit while 
drawing, you will hear a beep and drawing will stop. You can 
draw a second line starting where the current one ends. To 
do this, you have to deselect the first line by clicking outside 
the frame containing it, or the program will try to extend it, 
which cannot be done. Once deselected, you can start your 
new line. 

Polylines are a series of connecting straight 
lines. They are different to free-hand lines in that 
they are drawn a section at a time. You select the 
Polyline tool, then move the pointer to the point 
where you wan to start the line, and click. You do 
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not hold the button down. You then move the pointer to the 
next required point on the line, and click again. As with 
straight lines, there is a rubberband guide line. You repeat 
this for as many sections as you require. To end the polyline: 
you must move the pointer away from the last point and 
double-click. This is different to many drawing programs 
where you double-click on the last point to end a polyline. 

Circles, Ellipses, Rectangles are drawn by in 
effect drawing a containing box'. The box is the 
equivalent of the rubberband guide line. To do 
this, you select the appropriate tool, move the 
pointer to one corner of the containing box, and 
then hold down the left button and draw to a 
diagonally opposite corner. The object will be 
drawn to fill the box. A rectangle will cover the 
same area as the box. So will a rectangle with 
rounded corners, with the rounding within the 
box. Circles and ellipses will touch the box at the 
middles of the sides. Ellipses can only be drawn 
with the axes vertical and horizontal. They cannot 
be orientated at an angle. 

Sizing and Moving 
Graphics objects can be changed in size and position after 
drawing. When an object is selected (by clicking it), ' handles' 
appear around it (see Figure 4.1). You can change the size 
(and in appropriate cases shape) of an object by placing the 
pointer on one of these handles and dragging. By dragging 
on a corner handle, the object can be altered in both length 
and height. By dragging on a side or top handle, the object 
can be changed in one direction only. 
Objects can be moved by placing the pointer on them and 

holding down the left button. They can then be dragged to a 
new location within the same frame. Graphic objects cannot 
be placed outside of frames, of course, and to move an 
object from one frame to another, you must use the 
clipboard. Select the object, then choose Cut or Copy from 
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the Edit menu. Then select the frame to take the object, and 
choose Paste from the Edit menu. 
Fine adjustments to the size of objects can be made using 

the Size and Position dialog from the Draw menu. The 
current dimensions (of the object selected when you pull 
down the menu) will be displayed in the dialog. Alternatively 
you can double-click on the object to display the dialog. 

Adjustments to size and position can be made, in the current 
units, and the changes take effect when you click on OK. 

Figure 4.1 Graphics objects with handles' around ellipse 

If you change the size of a frame, normally the size of the 
drawn graphics will also change, maintaining their propor-
tions relative to the frame. If you want to enlarge a frame 
without changing the graphics, or shrink the frame to fit 
round what you have drawn, just hold down the Control key 
as you alter the frame size. Note that this will not work if the 
frame also contains a PowerText object. This is covered in 

Chapter 7. 

Line and Pattern Fill 

Drawn shapes (rectangle, circle, ellipse) have a fill. All 
objects have a line type. The fill pattern or tint can be either 
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opaque, so objects below are hidden, or transparent, so they 
show through. Both opaque and transparent fills can be 
plain, so that the object just appears as an outline. Various 
line widths are available, and line styles (dot, dash, dot-dash) 
are also included in the choice. However, these are not 
independently selectable. You cannot have a wide dotted 
line. 

Figure 4.2 The Fill Style dialog 

The fill pattern is selected in the Fill Style dialog from the 
Draw menu, as shown in Figure 4.2. In this, you can choose 
whether to have a perimeter line around the shape. This will 
follow the current line style if selected. You can choose from 
36 fill patterns and tints. You can choose to have the object 
opaque or clear, and you can select a colour. Note that if you 
choose a colour other than black for a monochrome printer, it 
will affect the appearance of any tint. The colour palette at 
the bottom of the Pressworks screen can also be used to 
change the fill style and colour. 
Note that if you choose to have a plain transparent fill and 

no perimeter line, you are producing an invisible object. All 
this will do is inflate the file size. 
The line style is selected in the Line Style dialog from the 

Draw menu, shown in Figure 4.3. In this dialog, you can 
choose the line style, the colour, and whether to have 
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arrowheads at the ends of lines. The settings you make 
here, except for the arrowhead setting, will also affect the 

perimeter lines of shapes if they have them. 

Figure 4.3 The Line Style dialog 

Note that if you have a graphic object selected while 
making changes in these dialogs, the object will be altered to 
reflect the changes. This can be used to alter objects 
deliberately, but can also result in accidental changes, which 
can be very annoying. You can make sure no object is 

selected by clicking in an empty part of the window before 
pulling down the menu. 
Remember that if you want the same graphics on every 

page of a document, they can be drawn on the master 
pages. However, if you do this after you have done some 
work on a document, they will only appear on the new pages 
added, not the existing ones. To place them on existing 
pages, you need to use the clipboard. Place the graphics on 
the clipboard using Copy on the Edit menu (or the toolbar 
copy button), and then place them on each required page by 
moving to the page, and using Paste from the Edit menu, or 

the toolbar paste button. Drawn graphics (on whatever page) 
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can be saved in a template, provided the page is saved as 
part of that template. 

Importing Graphics 

The graphics facilities provided in Pressworks are really 
intended for simple decorative features. Clever things can be 
done with them, but they are not adequate for real 

illustrations. Most of these will be produced using other 
graphics programs, or by scanning actual artwork or 
photographs. Both bitmap ('paint') and line art ('draw') 
programs can be used to produce illustrations for DTP. 

Bitmap Graphics 

Bitmap programs draw pictures 'dot-by-dot'. With these, 
though they provide straight line, rectangle and circle 
drawing tools. the results are stored only as the screen 

mom  
sum 

Figure 4.4 The Windows Paintbrush program 

picture, consisting of pixels. There is no record of the stages 
used to draw the picture. The objects drawn lose their 
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identity, and cannot be subsequently modified except by 
dot-by-dot erasure and redrawing. Areas of the picture can 
be selected and moved or deleted, but individual features 

which overlap cannot be treated separately. 
Bitmap programs are normally used to produce very 'free' 

pictures, with a lot of freehand drawing, 'spray can' and flood 
fill effects, and free colouring. They can be effective in 
documents in small sizes, but do not look good if too big, 
especially if the size is produced by scaling up. Figure 4.4 

shows the screen display of Windows Paintbrush, the free 
'paint' program which comes with Microsoft Windows. 

Line Art Graphics 
Line Art programs draw pictures object by object. The tools 

provided to draw the objects are similar to those included in 
Pressworks, but are much more extensive. As well as the 
various types of line, rectangles, circles and ellipses, there 
are likely to be facilities for polygons, irregular shapes, and 
polylines which may include curve or arc sections, and which 
may vary in width. Controlled curves (Bezier and/or spline) 

are normally included. Pattern fills are likely to be more 
flexible. You may be able to define your own patterns, and 
graduated fills, where the fill shades from light to dark, or 

from colour to colour, may be included. 
Line art drawings are not stored as screen images. They 

are stored as a file (in memory, as the picture is drawn) 
which records each object in the drawing, with all its 

attributes. This type of file is known generically as a 
'metafile'. Programs have their own metafile format, though 
many Windows programs can use the Windows metafile 
format. When a drawing is redisplayed, for example as the 
screen is scrolled, the image is redrawn by consulting the 
information in this file. This is sometimes called ' playing' the 
metafile. 
Line art is used mainly for more formal illustrations, such 

as plans and diagrams, and for special text effects, such as 

making text follow a curved path, or conform to the surface 

of a cylinder or sphere. They are, however, very versatile 
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and can be used to produce cartoon and poster-style 
pictures. They can produce large high-quality illustrations, 
and can also be used for small, detailed pictures. Scaling is 
possible with little or no loss of quality. Figure 4.5 shows the 
screen of GST Designworks, the line-art program which is 
perhaps the best partner for Pressworks. 
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Figure 4.5 The Designworks screen 
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Scanners 

Sometimes you will want to include an illustration which 
already exists on paper. This may be a drawing or a 
photograph. These can be used by 'scanning' them. A 
scanner produces a bitmap representation of the original. 
Colour and monochrome scanners are available. The format 
of a file from a scanner will be borrowed from a bitmap 
painting program. The PCX and TIFF formats are most 
common, though the Windows BMP format is now very 
common. Older scanners often offer the old GEM IMG 
format. In fact, most scanner control programs offer a choice 
of formats. 
When scanning artwork, most scanners offer a choice of 

letter (or line) or continuous tone scanning. Letter scanning 
will reduce the picture to areas of black and white only, with 
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no attempt to produce intermediate shades of grey. This is 
provided for scanning text for Optical Character Recognition 
(OCR) and is also useful for scanning line drawings. It should 
be used even where gradation effects are produced by 
'hatching'. 
Scanners have a light/dark control. This sets a 'threshold' 

at which the scanner jumps from producing black to 
producing white. It must be adjusted for best effect. If set too 

light, fine lines will be lost. If set too dark, lines close 

together may 'join up'. and other blocking up effects may 
occur. The 'best' setting may be a compromise between 
these. If you use the line setting to scan a photograph, this 
setting will determine the ratio of black to white. This is really 
a creative decision. 
When scanning a photograph, the continuous tone setting 

will preserve the gradation from light to dark in one of two 
ways. A true 'grey scale' image will record a brightness level 

for each point sampled. Most scanners give 256 shades of 
grey between black and white. The alternative is 'dithering'. 
In a dithered image, patterns of dots are used to simulate 
shades of grey. Normally only 16 or 32 shades are produced 

by this method. Dithered images have the advantage of 
smaller file sizes than grey scale images. 
Colour scanners store the image in a similar way to a 

grey-scale scan, but colour information is also stored for 
each point. It goes without saying that this results in even 
bigger file sizes. 
Scanners often offer a choice of two, three or more dither 

patterns. These patterns differ in their degree of fineness. 
The finest setting will retain the most detail, and is the best 
choice if all the copies of your document are to be printed on 
a computer printer or typesetting machine. However, if you 
are producing a 'master' which will be duplicated by 

.photocopying, it may be necessary to use a coarser pattern 

to prevent the picture from losing quality on the copies. 
Scanners also have a dot-pitch setting. This determines 

how close together the points sampled are. Setting a finer 
dot pitch (i.e. higher dots per inch), gives a more detailed 
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scan and a larger file size. Simple hand scanners may offer 
only three or four settings. More expensive scanners may 
allow dot pitch setting in 10 dpi intervals. 

Tracing Scans 
Some line-art programs include a trace' facility which allows 
scans to be converted to a line-art form. The trace feature 
finds the edges of areas in the scan, and draws lines around 
them. This will normally only work with line' scans, where the 
original is rendered as areas of solid white or solid black with 
no gradation. However, some better tracers will work with 
grey-scale or colour scans, if they consist of solid areas. 
Dithered scans cannot be traced with any great hope of 
success. 
Once the trace has been produced, it will consist just of 

black lines on white. Further work can be done on it using 
the line-art program's facilities. It may be possible to fill areas 
with colour, to do further drawing on top of the trace, and to 
alter or erase the trace lines. By this means, some very 
exciting graphics can be produced. 

Picture Import 
Whether line art, drawn bitmaps or scans, all pictures are 
imported in the same way. Selecting Import Picture from the 
File menu produces the Import Picture dialog, shown in 
Figure 4.6. This is a standard Windows file dialog. You 
choose the type of file you want to import in the List Files of 
Type list box, and then select the file you want from the list 
of files. The Importing picture file box is displayed during the 
importation, displaying graphically how the operation is 
proceeding. 
The imported picture is added to the browser. If you are in 

Frame mode when starting the operation, with a frame 
active, the picture will be placed in that frame. Otherwise, 
you can go to Frame mode, make a frame active, and then 
click on the picture name in the browser, to place it in that 
frame. Pictures can be placed in more than one frame in this 
way, if required. 

61 



Sizing and Scaling 
Normally, a picture will be scaled to fit the frame into which it 
is placed. You can make the picture the size you want by 
adjusting the size of the frame which holds it. If the 
proportions of the frame are different to the proportions of 
the picture, it will be scaled by different amounts in the two 
directions. In some cases, this may be acceptable, but often 
it will not. In particular, if a drawing contains circles or 
squares which must be the correct shape, this distortion will 
spoil them. 

Import Picture 

File Name. 

MCGI: 
ellal.pcx 
ella2.pcx 
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List Files of hme: 

PC Paintbrush Cpcx11  

Diiectories. 
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Drives: 

c-  Ld. 

Cancel I 

Help 

Figure 4.6 The Import Picture dialog 

The way in which scaling occurs can be controlled by 
choosing Picture Object Attributes in the Frame menu. The 
frame containing the picture must be selected when you do 
this, as the attributes are set individually for each picture. 
The Picture Attributes dialog, shown in Figure 4.7, contains a 
box labelled Aspect Ratio. If the check box labelled Preserve 
is checked, the picture will be scaled by the same amount in 
both directions. The scale factor will be such that the whole 
picture fits in the frame, with the picture centred in the 
direction in which it is smaller than the frame. You may wish 
to adjust the size of the frame to fit the picture, especially if 
the frame has a border. 
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Preserving the aspect ratio applies to both line art and 
bitmaps. There is a further consideration which applies only 
to bitmaps. Bitmaps can only be scaled in a rather crude 
way. Objects in the bitmap cannot be individually scaled, 
preserving their shape, as they can in line art, as they are 
not identifiable as individual objects. Scaling can only be 
done by doubling lines of dots, or by deleting them. For 
example, a reduction of size by 10% can be done by deleting 
every tenth row of dots. An increase of 20% can be done by 
doubling every fifth row. 

Picture Attributes 

Aspect Ratio r 

!Preserve 

'Whole Pixel Scaling 

E Horizontal 
E Vertical 

— 1,oiouriétti 

E Custom: 

OK 

Cancel 

Help 

Figure 4.7 The Picture Attributes dialog 

This crude scaling can produce some unpleasant effects in 
the picture. These are often described as 'tartan', 'checker', 
or Moiré patterns, the latter being not strictly accurate. This 
is perhaps most objectionable with dithered scanned photo-
graphs. Dither patterns are very carefully chosen to give the 
best effect. Any distortion of them is very noticeable. 
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To eliminate these effects, the Picture Attributes dialog has 
a section labelled Whole Pixel Scaling. This is only active for 

bitmap images. There are two check boxes, allowing whole 
pixel scaling to be enforced for the horizontal and vertical 
directions separately. 
Obviously, when you choose whole pixel scaling, it will limit 

the ability to scale the image If the image size is such that 
one pixel in the picture will print as one printer dot, and you 
enlarge the frame, the picture size will not alter until the 
frame is big enough for each pixel to print as two dots. If 
Aspect Ratio Preserve is checked, the size will not change 

until the frame is big enough for doubling in both directions. 
Despite this restriction, it is recommended that whole pixel 

scaling should always be used for continuous-tone scanned 

photographs, especially when dithered. Some control over 

size can be obtained by considering the printer resolution 
and the dot-pitch setting used in scanning. If you have a 
printer of 300 dpi resolution, normal for lasers and some 
inkjet printers, and you scan at a setting of 300 dpi, the 
reproduced picture will be the same size as the original (or 

double or treble this, and so on). If you scan at 200 dpi, the 
reproduction will be two-thirds of original size (or four-thirds, 
six-thirds, and so on). If you scan at 400 dpi, the 
reproduction will be larger than the original by one third (a 
ratio of 4:3). Of course, the extent to which you can use this 
depends on the choice of dot-pitches your scanner offers. 

If you turn on Whole Pixel Scaling when the picture is in a 
frame too small to hold it, you will see a message box telling 

you that whole pixel scaling is not possible. Whole pixel 
scaling will be turned off. You should therefore ensure that 

the frame is big enough to take the picture before turning 
whole pixel scaling on. 
Bear in mind that Pressworks always formats the docu-

ment for the printer, and whole pixel scaling refers to printer 
pixels, not screen pixels. Therefore, even when you have 
whole pixel scaling on, the screen representation will almost 

certainly show some patterning. Also note that the document 
is designed for a particular printer. If you try to print the 
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Figure 4.8 Whole-pixel scaling 

Figure 4.9 Unconstrained scaling 
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document on another printer with a different resolution, the 
size of pictures will change in consequence. Figures 4.8 and 

4.9 show the effects of scaling a dithered photograph. 
Figure 4.8 has whole-pixel scaling enforced. Figure 4.9 is 
scaled up slightly from this. Note the patterning. 

Cropping Pictures 
All types of picture may be cropped once in the document. 
To do this, while in Frame mode you select Crop Picture 
Object from the Frame menu. The frame containing the 
picture you want to crop must be selected before you do this. 
The pointer will change to the shape of a pair of scissors. 

The 'hot spot' of this cursor is where the 'blades' of the 
scissors cross. You move the cursor to one corner of the 
area you want to fill the frame, and then drag to the 
diagonally opposite corner. A dotted line guide box is drawn 
as you do this. When you release the mouse button, the 
area of the picture you have chosen will expand to fill the 
frame, subject to any settings in the Picture Attributes dialog. 
The picture itself is not changed by cropping, only the 

section of it displayed. You can restore the full picture by 
clicking on it in the browser with the frame selected. If you 
have cropped a picture and you paste it into further frames, 
they will get the full picture. To produce multiple copies of the 
cropped version, copy the frame complete with picture to the 
clipboard, and paste as many copies of this as required. If 
you include a cropped picture on the master pages, the 
cropped version will appear on each new page added. 
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5. FONTS AND TYPOGRAPHY 

Pressworks uses the fonts that Microsoft Windows uses. 
This simple statement hides a number of complications. 

Because Windows has been developed through a number of 
versions and over a number of years, while maintaining 
compatibility with previous versions to some degree. several 

types of font are supported. Some of these can be 
considered obsolete or unsuitable for serious DTP work. 

Bitmap Fonts 

The three broad categories of font are bitmap fonts, stroke 
fonts and scalable (or outline) fonts. Bitmap fonts were the 
original type used by Windows. Rather like bitmap graphics, 
these fonts consist of the actual pattern of dots which will be 
used on the screen or printer to display the characters. 
This type of font has to be specific to a particular device, 

screen or printer, and comes in specific point sizes. To have 
matching screen and printer displays, you need matching 

sets of fonts. Again like bitmapped graphics, these fonts can 
only be scaled in a very crude way, giving poor-quality 
jagged results, but scaling is unnecessary if you have a 
comprehensive set of sizes. 

Bitmapped fonts are still supplied with Windows for 
downward compatibility with previous versions, but for DTP 
work. are best avoided unless you have a good range of 
matching screen and printer fonts. perhaps carried over from 

a previous version of Windows. They are really made 

obsolescent by scalable font technology. 

Stroke Fonts 

Stroke fonts are designed for plotters, which work by drawing 
characters with pens. A stroke font consists of drawing 
instructions, similar to a line-art metafile. They can be scaled 
to any required size (within practical limits), but always 

consist very obviously of lines. There is no variation in 
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thickness in these lines, so the overall effect is weak and 
spidery. 
The thickness of the lines is normally one pixel on the 

output device. With a high-resolution printer, you will get very 
thin lines. This makes the best types of printer for DTP use 
the worst type for stroke fonts. This type of font cannot be 
considered suitable for DTP, unless you are using them for 
special effect. 

Scalable Fonts 
Scalable fonts are stored as drawing instructions which 
describe the outlines of the letters, hence the alternative 
name of outline fonts. These are similar to stroke fonts in 
some respects, but the outlines describe both the 'outside' 
outline and the ' inside' outline. This gives both the shape and 
the thickness of the characters, so that fully-formed letters 
are possible. With good scalable fonts, the quality can be 
very high. 
When a particular size of type is required, the outlines are 

scaled to this size, and the characters drawn and 'filled in'. 
The one outline can produce type of any required size, again 
within practical limits. This scaling and filling process can be 
very rapid, so it is done 'on the fly'. You do not need to 
prepare fonts in advance Windows 3.1 comes with a 
selection of TrueType scalable fonts, and the scaling engine 
is a part of Windows. Once a particular size has been 
produced, it is 'cached'. to avoid unnecessarily repeated 
work. 
Other scalable systems can also be added on to Windows. 

Adobe Type Manager is the best known of these. It uses 
PostScript Type 1 font outlines. This may be of some slight 
advantage over TrueType if you use a PostScript printer. 
Bitstream Facelift is another product of this type. It uses its 
own font format. 
The PowerText effects feature in Pressworks can use both 

TrueType and PostScript Type 1 outlines. It does not work 
with other outlines, or with other types of font. 
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Font Outlines 

Windows comes with a basic set of TrueType font outlines. 

These include Arial, a sans serif font similar to Helvetica, 
Times Ne l‘ Roman, a serified font obviously similar to Times 
Roman, and courier New, a typewriter monospaced font. 

These fonts are supplied by the Monotype Co. and are of 
very high quality. Each of these comes in normal, bold, italic 
and bold italic forms. There is also a symbol font. 
Pressworks comes with a set of GST's own outline fonts, 

also now in the TrueType format. Unfortunately, some of 
these effectively duplicate those supplied with Windows. 

GST's Sans is very similar to Anal, and Serif is similar to 
Times New Roman. Courier is obviously similar to Courier 
New. The others supplied include some well-known faces 
like Avant Garde and Iapf Cliancery, as well as some 
decorative original fonts like Sage and 8rmskrood. You may 
have near-duplicates on your computer if you wish. Unlike 
the GEM system, which used code numbers to identify font 
types and did not allow two fonts with the same number, 

Windows uses the font names and allows this. However, the 
more fonts you have on your machine, the longer Windows 
takes to start up. 
Many sets of additional fonts are now available from many 

suppliers. These vary greatly in quality and price. There are 
many packs of fonts, often offering around a hundred 
different fonts, at low prices. These need to be approached 
with caution. Though these packs may contain some good 

fonts, others can be decidedly ropey. Fonts in these packs 
are often rip-offs of registered fonts, produced by scanning 

samples and converting them to outlines. The quality 
depends very much on how well the scanning and converting 

is done. 
As well as the quality of the outlines, there are other 

aspects to TrueType fonts. TrueType fonts are 'hinted', 
which means that the outlines come with information which 

helps the scaling process. For example, where letters have 
small details, below a certain point size including these 
details may hinder readability. The hinting will suggest where 
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the scaling engine should begin to ignore this detail. Cheap 
fonts may include little or no hinting. 
To ensure the best quality, you should choose fonts from 

reliable suppliers. The suppliers of TrueType and PostScript 

fonts generally recommended include Monotype, Adobe, 

Bitstream and Agfa. Purchasing individual fonts can be very 
expensive, but these companies also supply sets of fonts at 
reasonable prices. 
You may find the large packs of fonts at low cost useful if 

you want to experiment with different typefaces, and you are 

not too concerned with quality. However, you will probably 
find you want to change to better fonts as funds allow. 

Font Styles 

Styles mean aspects such as bold, italic, and underline. Most 

TrueType outlines are supplied in sets of four styles, regular, 
bold, italic and bold italic (though headline' fonts sometimes 
come in bold versions only). These fulfil most typographical 
requirements. If you do not have the specific outline for one 
of these, the TrueType engine can in some cases synthesise 
it from the regular outline, but the quality of this will not be as 
good as a proper outline. This is especially true of 
synthesised italics, which are just produced by sloping the 
regular typeface. The design of true italic characters is 

usually quite different. Synthesised bold can be more 

satisfactory. Underline and strikethrough are always synthe-
sised. 
Weights other than normal and bold are recognised by 

Windows. These can include light, demibold, and black or 

heavy. However, these are still rare. Frankly, light fonts 
would not be a lot of use to most people anyway. They need 
a very high resolution printer to do them justice. Heavy or 
black fonts can be useful for headlines. You will find special 
packs of headline fonts including these from good suppliers. 
The synthesising the TrueType engine will do is limited to 

bold from a normal weight, and italic from a regular font of 

any weight (to the same weight). You cannot synthesise a 
heavy font from bold, nor can you synthesise a lighter 
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weight. However, some heavy fonts report to Windows that 

they are normal weight, in which case you may be able to 

synthesise a very heavy font. Underline and strikethrough 
can be added to any of these. 

Typography 
Typography is the art of styling and placing text on a page. It 

includes the choice of typeface, the size and placing of text, 
and the use of space around it. In Pressworks, a major part 

of this is the design of paragraph styles. 

Changing and Creating Styles 

Pressworks starts with a selection of paragraph styles 
already defined. You can, if required, modify these to your 
requirements, and you can also add new styles of your own. 
Designing a paragraph style is one of the creative aspects of 
DTP. Full technical details of making changes are given in 
the manual and in on-line help. This section concentrates on 

the visual and creative side. 
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Figure 5.1 The paragraph editing dialog showing the font and 

point size display 

To edit an existing style. you can, while in text mode, 

choose Edit Paragraph Style from the Text menu, while the 
text cursor is in a paragraph of the type you want to change. 
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From Paragraph mode, the simplest way is to double-click 
on the style name in the browser, or double click on a 
paragraph of that type. You can also click in a paragraph of 

the type you want to change, then proceed as in text mode. 
The dialog produced is shown in Figure 5.1. 
To create a new style from Text or Paragraph mode, select 

New Paragraph Style from the Text menu. This produces a 
dialog in which you enter a name for the new style, and also 
the existing style from which you copy (see Figure 5.2). 
Obviously you choose the existing style most like the one 
you want to create. This initial copying is important to the 
program, as there are many aspects to a paragraph style, 

and all must have a value for the program to use. 

New Paragraph Style 

- New Style 

Name: 

Copy From: heading 2 
Headline 
Indent 
Left J 
Normal 

Help 

Figure 5.2 The New Paragraph Style dialog 

After this point, the procedure is the same. A dialog will 

appear in which you can make changes. Normally the first to 
be displayed will be to change font and size. However, if you 

have already been making changes, the one displayed 
initially will be the one you used last time. Each dialog 
contains seven buttons to the left of the box, and these can 

be used to switch quickly between the aspects. You choose 
the aspects you want to alter, and make the required 
changes. You may change several aspects in one go, but 

the changes are not displayed in the paragraphs until you 
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close the last dialog with the OK button. All changes can be 

abandoned with the Cancel button. 

Font and Size 

The dialog used to set the font and size can be seen in 
Figure 5.1. The font name is chosen from a list box. You 

need to choose a face which is suitable for the purpose of 
the paragraph style. The dialog shows a sample of the font 
to help you choose. For substantial amounts of text, 
readability is important. This means a design which is clear 
and not too fussy, and often will mean a serified font (one 

with little feet to the letters). However, some sans serif fonts, 
like Helvetica (a variant of which is used in this book) are 
also very easy to read. 

The use of script (handwriting), brush script, Old English or 
Old German style typefaces is best avoided for long text 
items. They are fine for headlines or captions, or in 
certificates or invitations, but in bulk they are very hard to 

read. 
For body text, point sizes of 10 to 12 are best, though 

smaller sizes can be used if the document is to be printed on 
a high-resolution typesetting machine. 12-point should be 
easily readable, even if printed on a dot-matrix printer. Sizes 
larger than this are best kept for subheadings and headings. 

The exception to this is, of course, if you are producing 
material for people with eyesight problems. Sans Serif fonts 
are often preferable for these people. 

The font style can be set to Regular, Bold, Italic or Bold 

Italic. Not all typefaces may offer all these choices. If you do 
not see one or more of these styles offered, it means the 
appropriate outline is not installed, and the missing style(s) 
cannot be synthesised. If ' Bold' is shown in inverted commas 

in this dialog, it means that the installed bold outline is, in 
fact, demibold (or semibold) or perhaps black or heavy. 
Lucida Sans is an example of a font which is supplied in 
normal and demibold weights. You can see the strength of 
the effect from the sample. 
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Italic text is harder to read than regular, so it should in 
general not be used for bulk text. It is, however, conventional 
to use it for captions, and sometimes for subheadings, in 
which case it may be combined with Bold. 

Printing whole paragraphs in Bold is really only appropriate 
for headings. Often, especially in books, it is better to use 
the same face and size for minor headings as for body text, 
but in bold face. 
Pressworks allows the width of fonts to be varied. This can 

be from 25% to 200% of the normal width. This should be 
done with discretion, but can be very effective sometimes. 
Making a font narrower to cram a lot of text into a small 
space is generally undesirable. Some typefaces come in 
narrow versions. If available, it is better to use one of these 
rather than compress a normal font. Tall, narrow fonts can 
be used in headlines very effectively, but reducing any font 
below about 60% of normal width will seriously compromise 
readability. 
Stretching fonts horizontally is often more successful than 

compressing them. Again, this is unlikely to be a good idea 
for bulk text, but can be useful for headlines for specific 
purposes, and for titles of documents such as newsletters. 
By all means experiment with these effects, but don't get 
carried away. It is always a good idea to seek a second 
opinion! Generally, you are likely to be more satisfied with 
the effect of stretching an intrinsically wide font ( like Avant 
Garde), or compressing a tall font (like Palatino) than the 
converse, but fonts look best the way their designers intend 
them to look. 
Sometimes, script fonts can be made more readable by 

'stretching' them to around 125% of normal width. However, 
even with this, they are rarely a good choice for body text. 
Underline and strikethrough are not set from this dialog, 

perhaps indicating that they are not suitable for use on 
complete paragraphs. The use of underlining in documents is 
best avoided. It looks ugly, even in headlines. It is always 
better to use bold or italic for emphasis. If you really want to 
use lines under headings, it is better to draw the lines with 
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the graphics tool than to use an underlined font. The 
underline is always too close to the letter bodies. Strike-
through is even more limited. These features are set by 
choosing Style from the Text menu, and selecting them in 
the second-level menu this produces. 

Paragraph Dimensions 
The Paragraph Dimensions dialog (see Figure 5.3) sets the 
margins (between paragraph and frame) and space above a 
paragraph, and the line spacing. Unlike some other DTP 
programs and word processors, Pressworks does not have a 
setting for space below a paragraph. 

Matgins 
CM. 

Space Above: 

First Line Left Indent: 

Left Indent: 

Right Indent. 

0.00 

0.30 

0.00 

0.00 

- Line Spacing 

Leading: 

Ei Align Baselines 

12.0 Points 

Figure 5.3 The Paragraph Dimensions settings 

The Space Above setting gives the space between 
paragraphs. If this is set to zero, the normal line spacing will 
be left between paragraphs. This is useful for densely-set 
text if you indent the first line of each paragraph (as in the 
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body text of this book). If you do not indent the first line, the 

text will not be clearly divided. 
If you prefer block paragraphs, without first line indent, you 

should set some extra space above. As a general recom-

mendation, this should be at least half the normal line 
spacing extra. Note that this spacing is set in the current 

units, not in lines or points (unless points is the current unit). 
This extra space will not be left if the paragraph is at the top 

of a frame. 

Indents 
The First Line Left Indent and Left Indent settings set the 

distance between the left side of the frame and the left edge 
of the paragraph. If you prefer no indent to the first line, 

these two should be made the same. If the first line indent is 
made less than the left indent, you will produce a 'hanging 
indent' or butdent. Some left indent for lines after the first is 
essential if you are to produce a hanging indent. Text cannot 

extend outside the frame. The Right Indent sets the distance 
between the right edge of the paragraph and the right side of 

the frame. The effect of these settings is dependent on other 
things, including the alignment. If the text is not justified on 
one or both margins, the settings made here will be the 

minima. 
It is not necessary to leave space between the frame and 

the text, unless the frame has a border style. The width of 

the visible border will be deducted from the available frame 
width, so the text will not be superimposed on the border, but 
if the indents are zero, the text will touch the border. In 
bordered frames, therefore, it is a good idea to use 

paragraph styles which have left and right indents on all 

lines. 

Leading 

The Leading setting sets the interline spacing. The initial 
size displayed will be derived from the font point size, and 
will give a normal' single-line spacing. For example, 10-point 

text will normally be on 12-point leading, often written as ' 10 
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on 12' or 10/12. This automatic spacing will be satisfactory in 
most cases, but if your paragraphs have long lines ( i.e. more 

than about 65 characters per line average) you may need to 
increase this spacing. If you do not do this, readers will have 
difficulty finding the start of the next line when reading. On 

the other hand, if you are using large point sizes for 
headlines, and these will spread over multiple lines, you may 
find a smaller spacing looks better. This is especially true if 
headlines are in all capitals. Large text in posters can also 
look good closely-spaced. 
Align Baselines is useful when using multi-column layouts. 

It ensures that the tops and bottoms of the columns are 
aligned. This is of most use where headings are interspersed 
with body text in columns, and is most useful when applied 
to Body Text. Note that it may make the spacing between 
paragraphs alter to align the following text. This is not a form 

of vertical justification'. It will not ensure that the last line of 
text in a frame is always placed at the very bottom of the 
frame. Pressworks cannot do this. 

Imported Styles 

When text is imported in a compatible format with paragraph 

styles, these styles will be added to those listed in the 
browser. The styles will be copied as closely as possible in 
Pressworks. Line spacing will be converted to leading in 
points, and margins and indents will be preserved as closely 

as possible. 

Problems can arise from two areas. Firstly, right indents 
are sometimes lost. The Author has not found any regular 
pattern here. It may be a problem with the word processors 
rather than Pressworks. Secondly, some word processors 
include a setting for space below a paragraph. This is also 
lost. If you have used space below, you may find it 
necessary to define a new paragraph style to cope with any 
problems caused. 
As an example, in Word For Windows, this document uses 

a paragraph style called Flush. This is the same as Normal, 

but without the first line indent. It is used after headings and 
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subheadings (Heading 1 and Heading 2). It has no space 
above. In Word for Windows, Heading 1, the main chapter 
heading, has a Space Below setting of 1 line. This is lost 
when the document is imported into Pressworks. 
To correct this, in Pressworks a paragraph style called 

First has been defined. This is the same as Flush, but with a 
Space Above of 0.6cm. The style of this first paragraph is 
changed after importation. Of course, if the Word for 
Windows template had been designed for use with Press-
works originally, this problem would have been avoided from 
the start, but this template was designed to produce 
camera-ready copy direct from Word for Windows. 

Paragraph Options 
This dialog (shown in Figure 5.4) sets the alignment of the 
paragraph and the bullet and language to be used. 

- Alignment 

0 Justified 

O Flushed Left 

0 Centred 

O Flushed Right 

0 Table 

Language í 

English (UK) Ld 

Bullet 

' 1 6 

 - EH 

El No Bullet 

Bullet Font: 

Anal Narrow Iii 
El Show Symbol Fonts 

Figure 5.4 The Paragraph options 
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The alignment determines how the paragraph will be 
arranged between the margins. If the paragraph is justified, 
extra space will be allowed between words so that both left 
and right margins are straight. This paragraph is justified. 
A flushed left paragraph will have a straight left margin, but 

no extra space will be allowed between words so that the 
right margin is ragged. This paragraph is flushed left. Some 
people think this gives a better appearance, as it avoids wide 
gaps between words, and extra space between characters. It 
is best kept for single-column text unless wide margins are 
used. If the space between two columns is small, it is better 
to use justification, or reading will become difficult. The use 
of a rule between columns is an alternative. 

This style does not overrule the setting of the first line left 
indent. If the paragraph style has an indent or outdent set, it 
will be formatted as intended. Even so, it is probably better 
used with a flush left first line, and extra space between 
paragraphs, though this is a matter of taste. 

Centreelparagraphs will have equal 
left and right margins to each line, 
but the margins -will- be different  for 
each line. This _paragraph is centred 
This style is suitable for headings, 
and in a script font for certificates 
and invitations, but is difficult to 
readfor bulk text. Again, any first 

line indent setting is observed 

A flushed right paragraph has a straight right margin, but a 
ragged left margin. This is a flushed right paragraph. This is 

perhaps the least useful type of justification, but it can be 
useful for headings, or for producing various types of 

symmetrical page layout. Sometimes, lists of various sorts 
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can be produced by using two frames, using a flushed right 
paragraph style in the left frame and a flushed left paragraph 

style in the right frame. A first line left indent setting different 
to the left indent will be honoured, but it affects where the 

first line will be word-wrapped, su may not be truly effective. 

If you set a bullet for a paragraph, it will place a special 
character (the actual bullet) to thé left of the first line of each 
paragraph. This style is used mostly for lists. The bullet can 
come from a different font to that used for the rest of the 
paragraph. There are special bullet fonts, and symbol fonts 

can also be used. With bulleted paragraphs, it is normal to 

create a hanging indent, setting the first line indent less than 
the left indent, so that the bullet is placed to the left of the 

rest of the paragraph. Remember only the first line gets a 
bullet. 

Break Control 

The Break Control dialog (see Figure 5.5) controls what 
happens when a paragraph is split across two pages or 
columns. If you set the Keep Whole checkbox, the para-

graphs will never be split. If there is not enough room for the 
paragraph at the end of a frame, it will be moved into the 
next in its entirety, leaving a space at the bottom of the 

previous one. This is most useful for headings which may be 

spread over several lines. 
When a paragraph spreads across pages or columns 

(across frames in Pressworks), it sometimes happens that a 
single line is left at the bottom of one page (called an 

'orphan), or a single line is carried over to the next (a 
widow). This can cause difficulty in readability, especially if 
the single last line is a single word. The Widow Lines and 
Orphan Lines settings let you set a minimum number of lines 
which will be left behind or carried over. 

The normal setting of 2 lines is the best compromise in 
most cases. It ensures readability, and minimised gaps left 
at the bottom of frames. Some people, however, prefer a 
setting of 3 or 4. 
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With a setting of 2, if there is only room for one line at the 
bottom of a frame, the whole paragraph will carry over to the 
next frame. If only one line will be carried over to the next 
frame, in fact two will be carried over, leaving a gap at the 
bottom of the first frame. Using a setting higher than 2 can 
result in bigger gaps. Widow and orphan control only works if 
Keep Whole is unchecked. 

Figure 5.5 The Break Control settings 

Orphan Lines: 

D Start on New Page 
D Start in New Frame 

E Keep With Next 
E Keep With Previous 

The Start on New Page setting will force a new page to be 
started whenever a paragraph having this style is encoun-
tered. Similarly, the Start in New Frame setting will force a 
paragraph of that style to be placed at the top of a new 
frame. These settings only make sense when a story is 
being flowed between pages and frames. 
The Binding settings are very useful. You can choose the 

paragraph style which will follow from the style you are 
defining. For example, in writing this book, the Heading 2 
style is followed by a style called Flush, which is not indented 
on the first line. This style is followed by Normal, which is 
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indented, and Normal is followed by Normal. (This is actually 
done in Word for Windows, but the Pressworks facility works 
in much the same way.) This setting is most useful for when 
typing in large amounts of text. Note that when paragraph 
styles are copied from imported text, any binding in the 
paragraph styles is lost, but can be reset manually. 

The Keep With Next and Keep With Previous check boxes 
control what happens at frame breaks. By setting a heading 
or subheading style to Keep With Next, you can prevent the 

heading from being separated from its text (a form of 
orphan). Keep With Previous is probably less useful (which 
means the Author cannot think of anything to do with it!). 

Word Spacing 

This sets the maximum and minimum spacing allowed 

between words. These dimensions are used when adding 
space to justify a line. The minimum and maximum settings 

may be the same, but if you make the maximum less than 
the minimum, they will be changed to 0.3 and 0.1 ems (an 
em is the width of a letter m in the font you are using). 
Limiting the space which will be added between words 
reduces the chances of 'rivers' of white space running down 
paragraphs. 

If a line of type cannot be justified by adding the maximum 

amount of space between words, extra space will be added 
between characters. If you uncheck the Letter Spacing check 
box in this dialog, this will not be allowed. Making these 

settings too restrictive is inappropriate for a justified para-
graph style. 
The Hyphenation Hot Zone setting sets the area where the 

lines will be wrapped in a flushed- left paragraph. The width 
of this zone determines how ragged the right margin will be. 

For actual hyphenation to occur, the Hyphenation check box 
must be checked in this dialog. Hyphenation is done 
automatically using a hyphenation dictionary supplied with 

Pressworks. Hyphenation can become excessive and irritat-
ing if text column width is too narrow. 

82 



Monospacing 

Monospaced fonts have equal widths for all characters, 
including spaces. They are like typewriter fonts, and are 
sometimes used for tabular data, so that characters line up 
in columns. This can be useful for financial and numeric 
data, though all numbers have the same width in many fonts. 
Pressworks will not automatically treat a monospaced font 

as monospaced. It may, for example, add space between 
words and characters to justify lines. By turning on 
Monospacing in the Word Spacing dialog, you will ensure 
this does not happen. 

Letter spacing and justified alignment cannot be used in 
conjunction with monospacing. Monospacing is only appro-
priate with a true monospaced font, such as Courier, Letter 
Gothic or Lucida Sans Typewriter. With other fonts, letters 
have different widths (proportional spacing). 

Tabs 
Tab settings control where the cursor will move to when the 
Tab key is pressed. They are used for setting up columns 
within paragraphs, for instance for tables. There are various 
types of tab. Left tabs are the most common type. Text will 
be left-justified on the tab position. With right tabs, the text 
will be right justified at that position, and with centre tabs, the 
text will be centred on the tab. Decimal tabs are used for 
numeric data. The figures will be justified with the decimal 
points aligned vertically 

Character Sets 
There are many more characters in fonts than can be typed 
direct from the keyboard. These, in most character sets, 
include extra punctuation marks, accented letters, and 
foreign currency symbols. Though you can type the typewrit-
er-style single and double inverted commas ( ' and ") from 
the keyboard, the proper ones as used in printed matter Ç' 
and ") are available and look much better. 
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You can also buy symbol fonts. The various types 
available include decorative characters, business symbols 
(telephone, credit cards, warning signs), and mathematical 
and scientific symbols. As few, if any, of these coincide with 
the keyboard keycaps, selecting the ones you want to use 
need an extra facility. 
Pressworks comes with an extra program which helps to 

select and insert special symbols and characters. This 
program, Keypad, is installed along with Pressworks, and 
can be run at any time from the Text menu by choosing Run 
Keypad. Figure 5.6 shows the Keypad screen. 

KeyPad:: Bresson - Pidure 

Options Help 

1111 238 Lucida Bright Math Ifjxl 

D -e_ 
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Figure 5.6 The Keypad program 

Keypad displays the complete character set for any font in 
its window. As some characters, punctuation marks espe-
cially, are very small, the characters can be displayed at 
different degrees of magnification. When you click on a 
character in this window, it is highlighted, and a larger 
representation of it is displayed on the character button in 
the toolbar. The code of the character is also displayed in 
this toolbar. 
To use Keypad to insert characters in a document, you 

must be in Text mode, and the insertion point must be 
placed where you want to insert the characters. You must 
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then run Keypad, if it isn't already running. If it is running, 
selecting Run Keypad will bring the Keypad window to the 
top. It will not run a second copy. You then choose the 
character you want to send and click on it. You then click the 
character button to send the character. Using Windows 
facilities, the character code is transmitted just as if it were a 
keypress. 
Normally, the character which appears in the Pressworks 

document will be in the current font. If you have switched to 
a different font in Keypad, you can send the font information 
as well as the character code. To do this, before sending the 
character, select Preferences from the Keypad Options 
menu. This dialog allows the font to be selected (this can 
also be done from the toolbar list box), and has Action and 
Display boxes with check boxes for various features. Send 
Font Information must be checked for this additional 
information to be transmitted. 
Keypad can be used with some Windows programs other 

than Pressworks. However, the font information can only be 
used by Pressworks. 

The Alternative Method 
(Apologies in advance for the pun which will emerge.) 
Though Keypress is effective for finding characters and 
symbols which are only used occasionally, it is a little slow 
for those special characters which are used frequently. 
These are, for most people, likely to include the single and 
double inverted commas, and also perhaps things like the 
copyright and registered trade mark symbols. 
For characters like those, it may be better to memorise the 

codes for them. This is not difficult for a few frequently-used 
ones. For example, the codes for the opening and closing 
single inverted commas are 145 and 146, and the double 
equivalents are 147 and 148. When you know the codes, the 
characters can be entered quickly using the Alt key. 
This has been a feature of DOS since its inception. There 

is one small difference with Windows. The code must always 
be given a leading zero. For example, to enter the opening 
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inverted comma, you hold down the Alt key, and type 0146 
on the numeric keypad. You then release the Alt key and the 

character appears. It must always be the numeric keypad. 
The number keys above the letter keys will not work. Once 
the character is inserted, it can be treated like any other and 

deleted, if required, in the normal way. 
This technique can also be used to enter characters in the 

text boxes in the Search and Replace dialog. 

Local Font Changes 

Normally, the font to be used will be specified in the 
paragraph specification. However, you may want to change 

just one, or a few, characters to a different font, or perhaps 
to change just one paragraph, so that it is not really 
necessary to define a new style. 
Changes like this are made from Text mode. To change 

any number of characters, they must be selected. To do this, 
place the insertion point to the left of the first character, and 
hold down the left mouse button and drag to the right of the 
last character (this can also be done in the reverse 
direction). The selected characters will be highlighted. You 
can then select the new font from the list box in the toolbar, 
or from the Font and Size dialog from the Text menu. The 
characters will remain highlighted so you can make further 
changes. 
You can mix font sizes on a line. The baseline will be 

moved down to accommodate the largest font. 
The font used for a whole paragraph can also be 

changed from text mode. The paragraph should be 
highlighted, and the font can then be changed from the 

Font and Size dialog as above. This will not change the 
font for other paragraphs of the same style. 

Kerning 

In proportionally-spaced text, certain letters look better if 
moved closer together. This applies especially to letters with 
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sloping sides, and the classic example is AW'. These letters 
can actually overlap horizontally. 
The process of moving letters closer together in this way is 

called Kerning. To some extent, it is automatic. Good fonts 
will be provided with Kerning Tables, included in the font 
outline file. These tables are used automatically to move 
appropriate letter pairs closer together. 
For body text, there should be no need to interfere with this 

process. However, for large-size type, as in headlines and 
for posters, the amount by which letters are moved together 
may be inadequate. Also, some poor-quality fonts may have 
only a limited number of Kerning pairs' in the tables, or even 
none at all (the best fonts have thousands). 
To move letter pairs closer together, you place the text 

cursor (insertion point) between the two characters. By 
holding down the control key and pressing the ' k' key, the 
letters can be moved together in 1/2 point intervals. Using the 
shift-control-k combination will move them apart by the same 
amount. If you want to set more exact intervals than this, you 
can use the Kern Two Characters dialog. This is produced 
from Kern on the Text menu. Intervals of 0.1 point may be 
set. Setting zero in this dialog resets default spacing. 
Figure 5.7 shows some text without Kerning. Figure 5.8 

shows the same, but with appropriate characters moved 
closer together. 
When setting Kerning from the appearance of the screen 

display, bear in mind that this is not always an exact 
representation of the printed form. In particular, you may find 
that the printed characters appear closer on the final printed 
sheet than on the screen. If you set ideal screen spacing, the 
characters may even touch when printed. 
As well as moving characters closer together, Kerning can 

be used to move them apart, by entering negative values in 
the dialog. This is useful for headings if you want to produce 
a 'spaced out' appearance. 
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BE AWARE 
OF WAVES 

Figure 5. 7 Text sample without Kerning 

BE AWARE 
OF WAVES 

Figure 5.8 Kerned text. The A, W and V characters have 
been brought closer together by 9.5 points on a 48-point 
font 
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6. PUTTING IT TOGETHER 

The steps used in preparing a document, in the order you 
would carry them out, are: 

1. Design or load a template 
2. Import the main text file and place it 

3. Tag paragraphs and make other changes to the text file 
4. Import and place the illustrations 

This order is not sacrosanct, and may not be applicable to all 
types of document, but it is the order which will generally 

involve least work. In particular it will avoid having to repeat 
tasks, if changes disrupt previous work. This chapter brings 

together the techniques described in the earlier chapters. 

Text Autoflow 

On early versions of Timeworks Desktop Publisher, the 
process of importing and placing a long story was a long and 

irritating one. It involved adding new pages one by one, then 
clicking in the frames to place the text. If you forgot to place 
the frames on the master page, you had to draw them as 

well. Not the most interesting of tasks. 
Fortunately, Pressworks has Autoflow, which automates 

this task. With a long story. it can flow from frame to frame 
on a page, and extra pages can be added as necessary, 
until all the story is placed. All this happens automatically 
after the first page of the story, without action being 
necessary on the part of the user. 

You can autoflow more than one story in a Pressworks 
document, but the stories cannot overlap on pages. That is 
to say, for example, you cannot have one story in a left-hand 
column and another in a right-hand column in a two-column 
layout. You can do this manually, but not using Autoflow. It is 

possible for the end of one story and the beginning of 
another to be on the same page. but not more than that. It is 
also possible to place one story in the middle of another. 
This is useful for adding an additional section. The parts 
remain as separate files. 
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You cannot select Autoflow until you have started to place 
a story. First you must import the text, and then, if the 
frames to take it are not on the master pages, you must 
draw them on the page where you want to start the story. If 
the frames are on the master page, move to the page where 

you want the story to start. This does not have to be the last 
page of a document if you have already placed other 

material. If you want to start the story in the middle of a 
document, there must be empty frames on your selected 
page, or you must draw some. 
You must start placing the story by selecting a frame, then 

clicking on the story name in the browser. The start of the 
text will appear in the frame. If you want it to flow to other 
frames, select them and click on the story name in the order 
in which you require the text to flow through them. This 
frame order will also be followed on automatically added 
pages. 
When you have selected all the frames to be used on the 

first page, if some of the story is unplaced, the bottom of the 
last frame will be dotted. At this point, you select Autoflow 
Text from the Text menu. Pages will be added automatically, 
and the text flowed through them, until all the text is placed. 

If you have started a new story in the middle of a 
document, the pages will be inserted at your start point, and 
the existing pages renumbered. 

You do not need to start autoflow from the first page on 
which you place the story. You can manually place the story 
over several pages, not necessarily contiguous, and then 

start autoflow from the last page it is on. However, once 

autoflow is started, the added pages will be contiguous. You 

can add pages or additional frames in the middle of an 
autoflowed story without the story occupying them. 

If, by editing processes such as changing paragraph 
styles, or by adding frames for pictures which displace text, a 
story no longer fits into all the pages it is on, you will not 
immediately be warned of this. You need to check the last 
page of the story, to see if the last frame has a dotted 
bottom line. This is the indicator if the story has overflowed. 
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With this frame selected, you can choose Autoflow again, to 

place the rest of the story, again adding pages automatically, 

as necessary. 

Manual Text Placement 

Autoflow is very useful where a document will have one or a 

few long stories in a regular page layout, such as in books or 
in formally designed magazines. For more informal layouts, 
and especially where there are many short pieces, autoflow 
may offer little advantage. In these cases, the text can be 

placed manually. 
After importing the text, manual placement consists simply 

of choosing the frames to take the story, and then selecting 
them in order, and clicking the name of the story in the 

browser for each one. You can choose the order in which a 
story flows through frames on one page freely, but a frame 

on a higher numbered page cannot contain a part of a text 
file which comes before a part which is on a lower numbered 
page. If you try to do this , the story will be re-flowed 

If you are using a layout where there are many small text 

frames mixed with picture frames, you may on occasion find 
that the flow of the text on a page is unsatisfactory. You can 
alter the order in which the story flows through the frames. 
Note that this operation needs a certain amount of faith, as 
in the intermediate stages it seems to be doing everything 

wrong. 
Start by selecting the frame where you want the story to 

start, and then click the story name. The order will change, 

and the story will be reflowed, but the last part of the story 
on this page will be placed in this frame at this stage. 

Next, select the frame to be second in order, and click the 
story name. Continue this for each frame, in the sequence 
you require. When you select the frame which contains the 
first part of the story and click the name, this will move to the 
first frame you selected. From then on, it is more obvious 
what is happening. Continue until all the frames you need to 

select have been selected. 
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You do not need to select all the frames containing the 
story. If only some of them are out of order, you only need to 
select these in turn. The first you select will, at the end of the 
operation, contain the first part of the story in the frames you 
selected. 

Frankly, you can end up in a mess doing this. If all else 
fails, you can clear the story from all the frames by selecting 
them and choosing Clear from the Edit menu, and then start 
from scratch. 

fiZe. 

-Document 

Name: ch6 

Size (Kbytes): 30 

Hombres ot Pages: 16 

Unused Frame (cm.): 5 

- language 

[English (UK) 

- Words 
Total 5376 

Number Placed: 5376 

Number Unplaced_ 

OK 

Help 

Figure 6.1 The Status dialog 

When placing a story, if there is more of it that is not yet on 
a page, the bottom of the last frame containing it will be 
dotted. You should always check for this, otherwise you may 
print your document with part of a story missing. ( In the 
manner of widows and orphans', the Author has come to 
refer to such missing bits as 'runaways') More information 
on a story can be obtained by double-clicking the name in 
the browser. This produces the story Status dialog. This 
dialog gives the name of the story, the file size on disk, the 
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number of frames used, and the amount of unused frame (if 
any). It also gives the number of words in the story, and the 
number unplaced (again, if any). This will tell you how much 
of a job you have in placing the rest of the text. This dialog 
can also be used to rename or remove a story. Figure 6.1 
shows this dialog, which can also be displayed by choosing 

Status on the Options menu. 

Skipping Pages 

If several stories share pages, and some stories are not 
placed on contiguous pages, you may want to put notices 
like "continued on Page 9" and "Continued from Page T' in 

appropriate places, to help readers follow it. Do not try to do 
this by inserting these as paragraphs into the story. If you do 
so, and you then do further editing or resizing of frames, the 
notices will be displaced. You may have some trouble finding 
them to move them back, as this will involve cutting and 

pasting. 
Notices of this sort should be placed in frames of their 

own. The story can then flow from page to page, but these 
notices will not move, as they are not part of it. Generally, it 
is easier to just draw these frames over the story frames. 
There is no need to clear the space where you want them by 

making the story frames smaller. Frames repel text by 
default, so parts of the story will not be hidden under them, 
provided you do not change this. As a general rule, there is 
no disadvantage in having overlapping frames. Remember, 

the limit is 100 on a page, and it is hard to reach this. 

Text Editing 

After a story is placed, you will normally want to go through 
the text to check for any errors. made either as it was written 
or in the importation process. You may also want to make 
some changes or improvements which could not be done 
when writing the story in the word processor. 

If the text comes from a source which does not support 
paragraph styles, and you have not used tags, the first thing 

Will be to go through it and tag paragraphs with the 
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appropriate styles. In particular, you may want to tag the 

headings and subheadings. 
As headings normally take up more space than the same 

material as body text, the story will grow as you do this. As 
this happens, the story may fill the last frame containing it. 
You will get no warning of this. It is therefore important, 
when you come to the last frame, to check for the telltale 

dotted bottom. It is possible to turn the display of frames on 
or off. You should always have them on display during 

editing. 
When changing the style of paragraphs, remember that if 

you want to change several to the same style, this can be 
done in one operation. This is a time-saver, as the text on a 
page is redrawn after each change. Having to wait for 
lengthy screen redraws after changing every paragraph is 
frustrating and time-wasting. This was a real annoyance in 

earlier versions. 
There are three ways to select multiple paragraphs, 

depending on whether or not they are continuous. If they are, 
you can (in Paragraph mode) select the first paragraph, then 
hold down the Shift key and select the last in series. All 

between will be highlighted. You can also achieve this by 
placing the paragraph pointer over the first paragraph, and 

dragging to the last. 
To select non-continuous paragraphs, hold down the 

control key and click on each. You can also select a 

continuous group of paragraphs as above, and then de-
select individual ones by holding down the control key and 
clicking on them. 
When you click on a paragraph style in the browser, all 

selected paragraphs will be changed to the new style. They 
will remain selected, in case you change your mind. 
The ability to change several paragraphs at once is 

particularly valuable with tables, where each line is normally 

a separate paragraph. It is also valuable with bulleted 
paragraphs, where you will normally have several together. 
Remember that groups of selected paragraphs cannot 

cross page boundaries. If you have selected paragraphs on 
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a page, and you select one on another page, the ones on the 
original page will be de-selected. 

Adding Pictures 

When the text has been imported, edited and styled, the next 
stage is to add the illustrations. The pictures are imported in 

a similar way to text, and are initially listed in the browser, 

unless an empty frame was selected when the importation 
was started, in which case the picture will be placed in that 

frame immediately (but still listed). 
Illustrations can also be added via the clipboard or as OLE 

objects. If you use a drawing package which runs under 
Windows, you can select the picture (or part of the picture) 
and copy it to the clipboard, normally by choosing Copy from 
the Edit menu in the drawing application. You can then 
switch to Pressworks, select the frame to take the picture, 
and then choose Paste in the Edit menu in Pressworks (or 
use the Toolbar button). This can be quicker than file 

importation. 
The pasted picture will be added to the browser, and so 

can be placed in further frames if required, by selecting the 
frame and clicking on the name. It is better to do this than to 

paste the picture again, as this will result in two copies in the 
document. 
OLE is described in Chapter 8. This is useful if you may 

want to change the illustration during the process of 
developing the document. 

Often, the illustrations will be placed among the existing 
text, by drawing new frames to take them. When doing this, 

it is better to draw the new frames over the existing text, 
rather than to adjust the size of the text frames. Remember, 
all frames are repelling when first drawn, so the text will be 
displaced rather than hidden. It is one thing to make an 
existing frame smaller, but often an illustration will be placed 
in the middle of a column of text. Having to split' a frame 
involves making it smaller and drawing a new one, then 
reflowing the text. Simply placing the picture frame on top is 

much simpler. 
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It is a good idea to save the document immediately after 
you have added each picture. Pressworks will occasionally 

stop with a General Protection Fault, and this results in the 
work you have done between the last save and the fault 
being lost. Pressworks has an automatic timed backup 
facility (select Automatic Backup from the Options menu), 
which can save the document automatically, perhaps every 
5 minutes, but this is only a palliative measure. It is still 

preferable to save manually after each major operation. You 
can do a lot of work in 5 minutes. Figure 6.2 shows the 
Automatic Timed Backup dialog. 
When adding pictures to a long document like a book (or 

Automatic Timed Backup 

- Options 

O Warning Beep 

ce Auto-backup 

• on 

Interval: 5 

Save As: ATB 

min. 

OK 

Cancel 

Help 

Figure 6.2 The Automatic Timed Backup dialog 

book chapter), it is best to start at the beginning and work 

progressively to the end. Illustrations and figures will 
normally be placed close to where they are referenced in the 
text. If you jump about in the document, adding frames, the 

text below the new frames will be moved, but the picture 
frames will not. The pictures will thus be displaced from their 
references, and it can involve a lot of work to move them 
back. 
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In Pressworks, there is no method of anchoring illustrations 

to text. Once pictures are placed on a page, they stay in that 
position, no matter how the text moves. It is much better to 
work from beginning to end, in a logical order. If you place 

frames containing captions under frames containing illustra-
tions, these also cannot be anchored together. 

Text Flow Around 

Frames start off repelling text in any frames under them. If a 
frame is drawn so that it fills or extends beyond the width of 

a frame containing text, the text will stop above the frame 
and continue below it. If the new frame only covers part of 
the width of a text frame, text will still be placed in the 
uncovered part. This is called text flow around'. 
This is the basis of many attractive page layouts. In 

particular, with two-column layouts, pictures can be placed 
centrally in the page, with the text in both columns flowing 
around them. 

Care should be taken not to leave too small a space for the 
text, so that the lines are very short. This will result in 
excessive hyphenation, and if the paragraph style is justified, 
it can also result in ugly wide gaps between words. This 
results in text which can be very hard to read, as well as 
being visually unpleasant. In circumstances like this, if the 
picture cannot be moved sideways or made smaller, it may 

be better to extend it so that there is no gap for the text. You 
can draw another empty frame to fill the gap if necessary. 
You don't have to put something in every frame in a 
document. 

If you are flowing text around pictures, it is a cardinal sin to 

have a heading or subheading in the narrow part of the text 
by the picture. This looks awful, and it does not respect the 
hierarchy which should exist between headings, subheadings 
and body text. There is more to headings and subheadings 

than just bolder and fancier text. They should be treated with 
consideration in placement as well. This does not apply if 
you are placing a small illustration appropriate to a heading 

to the side of it. This can enhance the heading. 
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When you have only a single column of text on a page, 
text flow around requires special consideration. A single 
column implies a small page size. In general, it is better if the 
illustrations use the full width of the page, or if empty 
'blocking' frames are used to stop the flow around. If you 
really want to have flow around, you should align the pictures 
with the left or right margin, and have the text to one side 
only. Never place an illustration in the middle of a column 
with text flowing down both sides. Reading the text is almost 
impossible. The reader may need to resort to a ruler to follow 
the lines. 

Irregular Shapes 

Normally, text flow around a picture will be around the 
rectangular frame containing it. However, some pictures will 
not be rectangular, so there will be some white space 
between the illustration and the text. In the Author's opinion, 
this is never objectionable, and can give a clean and 
attractive look to a page. 
Some typographers, however, insist on running the text 

around the irregular shape, despite the fact that the sloping 
margins which result (and especially a sloping left margin) 
can impair readability. Formerly, this was not possible in 
Timeworks Desktop Publisher, but the facility has, alas, now 
been included. 
To do this, new irregular frame sides must be drawn, 

consisting of straight line sections, rather in the manner of 
drawing polylines. You are, in fact, drawing new sides to the 
frame. You can have an irregular left side, or right side, or 
both. They are drawn separately. Each side will automatically 
be started in the centre top of the frame, and must end at 
the centre bottom. Each point in the line must be at the 
same level or lower than the previous point. It cannot be 
higher. 
To define a new border, you must be in Frame mode. You 

then select Text Runaround from the Frame menu. This 
produces the Text Runaround dialog. The 'Text runs around 
this frame' checkbox in this dialog must be checked for a 
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user-defined border to make any sense. This dialog contains 
two boxes for Left Border and Right Border. Each of these 
contains a Define Border button. Click the button for the side 
you want to define. Figure 6.3 shows this dialog. 

Text Runaround 

E Text runs around this frame 

Fiame Padding 
CM. 

Vertical Space: , 0.30 

Horizontal Space: 0.30 

- Left Border 

4.) Frame Edge 

Use' iJehistul 

Define Bolder I 

Flight Border 

(4.). Frame Edge 

lhei Oeiénieu 

Define Border I 

He 

Figure 6.3 The Text Runaround dialog 

You can now define the border by drawing the polyline. 
The first and last points are fixed at centre top and centre 
bottom, and, starting from the top and working down, you 
can define 29 points between them by clicking with the 
mouse (making a total of 31 points). Remember that each 
point you define must be on the same level as the previous 
one, or lower, but not higher. 

If you make a mistake, you can delete the last point you 
chose with the Backspace key. You can delete the whole 
polyline with the Escape key. Pressing Escape twice will take 
you back to the Text Runaround dialog. 
When you have drawn the polyline to your satisfaction, you 

can redisplay the Text Runaround by double-clicking or by 
pressing the Return key. The dialog will now contain an 

99 





A Concise Introduction 
to Pressworks 

by 

J. W. Penfold 

BERNARD BABANI ( publishing) LTD. 

THE GRAMPIANS 

SHEPHERDS BUSH ROAD 

LONDON W6 7NF 

ENGLAND 



PLEASE NOTE 

Although every care has been taken with the production of 
this book to ensure that any projects, designs, modifications 
and/or programs, etc. contained herewith, operate in a 
correct and safe manner and also that any components 

specified are normally available in Great Britain, the 

Publishers and Author(s) do not accept responsibility in any 
way for the failure (including fault in design) of any project, 

design, modification or program to work correctly or to cause 
damage to any equipment that it may be connected to or 
used in conjunction with, or in respect of any other damage 
or injury that may be so caused, nor do the Publishers 
accept responsibility in any way for the failure to obtain 
specified components. 
Notice is also given that if any equipment that is still under 

warranty is modified in any way or used or connected with 
home-built equipment then that warranty may be void. 

0 1994 BERNARD BABANI (publishing) LTD. 

First Published - July 1994 

British Library Cataloguing in Publication Data: 

Penfold, J. W. 
Concise Introduction to Pressworks 
I. Title 

005.369 

ISBN 0 85934 357 X 

Printed and Bound by Cox & Wyman Ltd. Reading 



PREFACE 

Desktop Publishing (DTP) is one of the most popular uses of 
computers. Pressworks, the latest version of Timeworks 
Desktop Publisher, is one of the most popular programs on 
PCs. It is a powerful and efficient program capable of 

producing high-quality documents. This book is designed to 
help you get the best from it. 
This book covers the whole process of producing a 

document, including adding text directly and importing it, 
adding illustrations, laying out documents, and adding 
special features. It pays special attention to the PowerText 
feature. 
Pressworks is also a Windows program, and this book 

includes a chapter on Object Linking and Embedding, the 
method of the future for using applications together. 
The program manual and on-line help give you the 'how' of 

using the program. This book goes further into the 'why' and 
'when'. It covers the design side as well as the purely 
technical. 
DTP is one of the many creative uses of computers. It is 

hoped this book will be a starting point from which you can 
discover both the usefulness and the pleasures of desktop 

publishing. 
The camera-ready copy from which this book is printed 

was produced using Pressworks. 
J. W Pen fold 
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option 
frame 

allowing you to choose between using the normal 
border or the user defined one. Click on OK in this 

dialog to close it and use the defined border. If 
you click on Cancel, the border you have just 
drawn will be lost. 

If you have a border style defined for a 
frame and you add a user-defined border, 
the border style will still follow the original 
rectangular shape. This means that text 
following the user-defined outline may 

run under the visible frame border. 
If the frame has a background tint, 
this will be contained within the 
user-defined border. Figure 6.4 

shows the user-defined bor-
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Figure 6.4 Drawing a 
user-defined border 

clip-art illustration inserted 
above. 
You cannot add a user-

defined border to a frame 
containing text. If you want 
to shape text, you can do it 
by drawing frames over it, 
and giving these user-de-
fined borders. Shapes need 
to be simple, because of the 
restriction that a point on the 
outline cannot be higher than 
a previous one. You should 
also avoid making the text 

too narrow at any point, though this may not matter if it 
results in a skipped line. 

Frame Padding 
When text runs around a frame, you may not want it too 
close to the frame edge. This applies especially if the picture 
runs right up to the frame edge, or if the frame has a border. 
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The text around the frame can be spaced away from it by 
setting the Frame Padding in the Text Runaround dialog. 

The padding is set separately in the horizontal and vertical 
directions, and is set in the current units. It was stated earlier 
that if you want to prevent a narrow text runaround to the 
sides of a frame, you can use empty blocking frames. You 

can also achieve this by using a suitably wide setting for the 

horizontal frame padding, but this margin applies to both 
sides. This can affect an adjacent column, which may be 

undesirable. 
When you have a user-defined border to a frame, the 

padding will be the offset from this to the text. Whether you 
need padding in this case depends on how closely you have 

drawn the border to the contents of the frame. 
The padding applies only to text outside the frame. To give 

clearance between a visible frame border and text within the 

frame, you must set suitable left and right margins for the 
paragraph styles used within the frame. 

The Creative Side 

The placing of text and graphics is more than just getting all 
the material into the document. The way in which the 

document is laid out can greatly contribute to, or detract 
from, its effectiveness. 
One of the most important things is to be consistent. This 

means using the same basic page layout (the margins 
around the printed part especially), and using the same 

typefaces and sizes for the same purpose. Using a lot of 
different fonts in a document can be done successfully, but 
usually it looks like the work of a rank beginner. It is also 
important to have a consistent approach for inserting 

illustrations, either aligning them with the text columns, or 
placing them across columns and flowing the text around 

them, or keeping text and illustrations in separate areas. If 
you mix these techniques, it will look as if the document has 
just been thrown together without thought. 
The more serious the document is, the simpler the layout 

will usually be. Technical books and works of quality 
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literature normally have a very simple, formal layout. Fashion 

magazines have a carefully contrived look of having been 

thrown together. 
With documents where both sides of the paper will be 

printed, and hence two pages will be visible at once, they 

need to be considered as a single entity for design purposes. 
They need to have either a symmetrical layout around the 

central spine, or a carefully-designed asymmetrical layout. 
Pressworks can display two facing pages together, and this 
feature should be used to view two-page spreads. Press-
works does not allow text or pictures to be spread across the 

central gutter between two pages. 

Readability 

Except where a document is a collection of illustrations, with 

the text not much more than captions, readability is perhaps 
the most important consideration. The width of text columns 
is a major aspect to this. How wide should a column be? The 
answer is 65 characters. It may be surprising that such a 
precise answer can be given, but it is a fact. Columns 
substantially narrower than this will give jerky reading, lead 
to excessive hyphenation, and make justification difficult. It 

can actually improve readability to use a smaller font rather 
than have too few characters in a line. If you have 

substantially more characters than this, readers will tend to 
`lose their place' as they go from the end of one line to the 
beginning of the next. This can sometimes be improved by 

increasing the leading, but this means less text on a page. 
The choice of typeface is also important. It is generally 

regarded that serified typefaces are more readable for body 
text. However, some sans serif faces are quite suitable, 
provided the size is not too small. Typefaces like Times 
Roman and Helvetica are suitable for both body text and 
headings. 
Fonts really designed for headlines and display work 

should be avoided for body text. Modern fonts like Avant 
Garde and Futura can be difficult to read in body text sizes. 

Fancy fonts are difficult to read in any size, but are 
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excusable in small amounts such as headings. Script and 
handwriting fonts are really meant for invitations and informal 
notices. 
The space between text columns is also important. If 

narrow, the eye may have difficulty in seeing the gutter as a 
separation between columns, and may try to follow lines 
across it. This is a problem particularly if the text in the 
columns is not justified. Narrow gutters need either justified 
columns or a rule between them. Wide gutters give a clean, 
open, quality look, and work best with a modern typeface like 
Helvetica or Zapf Humanist (GST's Autumn is similar). They 
do, however, reduce the amount of text on a page. If using 
wide margins between text columns, you should also leave 
wide spaces around illustrations. 

Decorative Features 
Decorative features include rules, boxes, tints, box outs, text 
effects. These can be used to brighten up pages. It is also 
common to give the first paragraph of a story or chapter 
some special treatment. 

Rules 
These are simple lines, which. in Pressworks, are drawn in 
Draw mode and can vary from very fine to thick, and with 
other variants. We have already mentioned that vertical rules 
can be used to separate closely-spaced columns of text. 
Horizontal rules are also useful for separation. 

It can be a good idea to ' rule off' text which appears on 
every page, such as headers and footers. The more 
extensive this text, the better the idea. These rules give a 
smart appearance, and make it easier to 'ignore' the headers 
and footers when reading the body text. As with margins 
between columns, if you use rules, you can leave less space 
between the headers and footers and the body text. 

It is not a good idea to place rules between headings and 
the material they head. It will tend to separate items which 
need to be held together. Also, placing a rule between a 
minor heading and the body text above it may imply more of 
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a separation than is intended. At the start of a chapter in a 
book, placing a rule between the chapter number and the 

title is acceptable. Placing it between the title and the start of 

the text generally is not. 
Remember that both white space and rules are separators. 

You must be careful not to separate things which are related, 
and also be careful not to fail to separate things which need 
separation. Either of these faults will make your documents 

hard to follow 

Boxes 
A box can be placed around text or a graphic either by giving 
a frame a border style or by drawing a box in Draw mode. 
Putting a box around illustrations is often a good idea. 
Bitmaps in particular can look better with a box around them. 

Otherwise, the edges can look ragged and untidy. This is 
very true with dithered scans, though getting a close fit can 
be tricky. 
Boxing text is another matter. Beginners often want to put 

everything in boxes. It can look very fussy and overdone, 
and can also cause confusion because, with everything in its 
own little box, it is hard to tell what goes together, and in 
what order you are supposed to read things. Like white 
space and rules, boxes are separators. 

Sex! Sex! Sex! 
will attract any eye. 

Boxes around text are best reserved for box-outs'. These 
are found mostly in magazines. They consist of a part of the 
text of the story, in a box, printed in a large (often italic) font, 
and often with a background tint. They are designed to catch 
the eye, and attract the interest of anyone casually flicking 
through the magazine. It follows that the text chosen will be 
of a controversial, or even salacious nature. Sex! Sex! Sex! 
will attract any eye. 
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A background tint will make anything stand out on an 
otherwise white page. They are often best used with a 

border style to avoid an untidy edge. Bear in mind that any 
tint will reduce the contrast of the text, and may make 
reading difficult, especially with small fonts. It is generally not 
a good idea to put a tint behind body text. This is a good way 
to antagonise readers. 
Another good way to antagonise readers is to print body 

text white on black. This can be acceptable for headings and 

box-outs, but is hard on the eye with small text. Not all 
printers are capable of printing negative text. Try a test on 

your machine before committing yourself to it. Those printers 

which cannot manage it will usually print plain black, rather 
than normal text. 

Text Effects 
Text special effects are now very popular. They include 

curved, rotated and skewed text, and various outlining 
effects. Pressworks has a special feature for these called 
'PowerText'. This is described in Chapter 7. 
For text effects more extensive than PowerText can 

produce, you can use an advanced drawing program. These 
do such things as fitting text to drawn shapes and bending it 

to fit a curved path. Designworks, also from GST, is a good 

match for Pressworks. It is a Windows program, so items 
can be transferred via the clipboard rather than by saving 
and importing files. Designworks also supports OLE (see 

Chapter 8). 

First Paragraph Treatment 

Enhancements commonly applied to first paragraphs include 
a large initial letter, commonly called a 'drop cap', printing the 
first word, or line, or the whole paragraph, in a larger font or 
in bold, using increased leading, and printing the paragraph 
on a tint, or as white-on-black text. Sometimes two or more 
of these are combined, and not always to good effect. 
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In Pressworks, drop caps can be produced with Power-
Text, and this is described in Chapter 7. The other effects 
are possible using standard DTP facilities. 
Special treatment should be reserved for paragraphs at the 

beginning of a story, or after headings. Do not use them for 

the first paragraph on each page, unless your document is 
designed so that these have special significance. 

If you add special features to the first paragraph after 
every heading, major and minor, you should grade the 

effects to reflect the importance of the heading. For example, 
if you use a drop cap and a larger font for the first paragraph 

after the main heading, you may just want to use one of 
these, the drop cap or the larger font, after the second-level 
heading. 

Example 

T his is an example of the treatment which can 
be given to a first paragraph after a heading. In this 

case, a drop cap is combined with a larger than normal type 
size for the first line. This is appropriate for the first 
paragraph in a story or a chapter, but might be considered a 
bit 'over the top' for a paragraph after a minor heading. 

On the other hand... 

For a paragraph following a minor heading, if any special 
treatment at all is required, it will probably be enough to just 
make the first word font size a little larger. This is effective. 
but discreet. Even so. techniques like this are more 

appropriate to magazines than to books. 
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7. POWERTEXT 

PowerText is an in-built feature in Pressworks designed to 
produce special text effects. These are mostly used as 
'Flashes' to add eye-catching features to pages, but they 
also have some more mundane uses. For example, the drop 
cap' example at the end of the last chapter was produced 

with PowerText (method described later), and it can also be 
used for captions for illustrations printed on a full page and 

rotated through 90° to give a landscape format. 

Pressworks cannot rotate normal text or graphics. Power-
Text is the exception. As well as being able to apply rotation 
to the text during creating the PowerText object, it is also 
possible to rotate the frame once the object is on the page. 
PowerText does have its limitations. Though a great many 

effects are possible, all the text in an object must be of the 
same type. That is to say, it must be in the same font and 
size, the same style, and the same colours. If you want text 
effects with mixed text types, you need a design/ drawing 

program, such as Designworks. These allow similar effects 
to PowerText, and some more elaborate ones, and allow 
mixing of fonts and styles. 

Producing PowerText 

To produce a PowerText object. you need to start by 
selecting the frame to take it. This frame must be empty. It is 
not possible to. put a PowerText item into a frame which 
already contains text or graphics, including graphics drawn 
with Pressworks facilities. However, it is possible to draw 
additional graphics in a PowerText frame after it has been 
created. 
Selecting PowerText from the Text menu will produce the 

PowerText dialog, shown in Figure 7.1. The text for the 
object is entered in this dialog. Up to three separate lines are 
possible, using the Enter key to start the subsequent lines. 
The text is limited to 80 characters, including spaces. The 

carriage return between lines adds a further single character. 
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This dialog is also used to select the font and size. 

PowerText will only work with the TrueType and PostScript 
Type 1 scalable fonts. Other fonts will simply not be included 
in the selection list box. 

PowerText 

ext 

ECIMIII2=1111 

Font: It Ceram Gothic  LzJ 
Italic 

rOptions Effects-

Sealing: 

flotation. 

Skew: 

D Milo, 

Line - Centie 

Fit Fiase 31. 

ne keggelts 

1IIII@ Delimits 

Points 

E àuto preview 

Figure 7.1 The PowerText dialog 

There are three aspects to entering the font size. You may 
want to match the font to text already in the document, or 
have it at a fixed size for other reasons. In this case, you set 
the Scaling to Fixed Size. and enter the point size in the box 
to the right of this. This size will not be altered if you adjust 
the size of the frame subsequently. If you set the scaling to 
Preserve Aspect, the point size box will be disabled. The text 

will be scaled to fit the frame, by equal amounts in both 

directions. It will be fitted to the frame in one direction, and 
space will be left in the other. Selecting Fit Frame will cause 

the text to be scaled to fit the frame in both directions, with 
no space left around it. 
PowerText can skew and rotate text. These effects are set 

separately, and can be used individually or combined. 
Skewing means giving text a forward or backward slope. 
Rotating means altering the baseline of the text from the 
horizontal. 
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A forward skew is suitable for something associated with 
speed and motion. 

New Sperfs Coupé Shown._ 
Note that in some cases, the appearance may not be a 

great deal different to italics. The effect may need to be 
more extreme (an angle of 15° or more) to be obvious as a 
special effect. The angle here is 25°. 
A backward skew will give the impression of looking to the 

past, of looking backwards, of retrogression. 

-,(\zucakim &Icy. 
As reverse- italics are quite rare, even a mild backward 

slope will look like a special effect. This example is at -20°. 
This can also be entered as 340°. 
When you rotate text, the containing frame will be rotated. 

This means that you cannot draw the frame to the exact size 
and position you want before calling up PowerText. It is best 
to draw the frame roughly at first, then adjust to size and 
position after it has been rotated. It is also possible to adjust 
the rotation angle. 
Downward-sloping handwriting is associated with depres-

sion. Downward-sloping text is also most appropriate to 
doom and gloom headings. 

Oh bear/ oh 

b ear! oL 

°ear , 
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Upward-sloping text has an upbeat nature, and 
is often found used for headlines in sports 

Note how text can be fitted 

around a rotated text frame, (>1° 

and teenage magazines. 

without having to draw a 
user-defined border. 

t 
However, the 
ext will be 

kept to GO 
one side of 

the frame 
only. It will not pass under it and continue on the other side 
unless Text Runaround is turned off. This will result in part 
of the text being hidden if the frame background is opaque, 
or partially obscured if transparent. You can make the text 

jump from one side to the other by moving the frame. 
If you use an angled frame in this way, you are likely to 

end up with an ugly empty triangle either above or below it. 
You may be able to fill this with a suitable graphic. The 
example above comes from the Pressworks clip-art, which 

you can use royalty-free in your documents. 
Rotated text and skewed text can be combined. It is often 

effective to match the angles, so you have upright text on a 
sloping baseline. This is easily done, by entering the same 
values for both effects. Note that for this to work, you must 
use Preserve Aspect or Fixed Size. If you change to Fit 
Frame, the skew will be lost. 

• 

In this example, it looks 

G leetiIIING 

quite good to have the text 
continuing under the headline. Pow-

i'llile erText frames are text frames, and can 
have  a setting for Text Runaround horizontal 

space, but not vertical space. If you need this, 
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you can always draw empty frames to clear the text from the 
area. 
So far, all the examples we have looked at have been 

straight lines of text. PowerText can also produce curved 
text, in complete circles or arcs. These are chosen from the 
Effects list box in the PowerText dialog. 

1.fi 
-0.° 0- 

o 

lei• in Q /2 
•&-) 0 

The Rotate and Skew settings can be used in conjunction 
with all the effects. Skew affects the characters as expected. 
Rotation rotates the frame on the page, and with it the 
orientation of the arc or circle. 

'SOf 

o 
a 
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Line and Fill Styles 

The text characters in a PowerText object actually consist of 

an outline and a fill. Normally these both take the current 
colour and style, by default solid black. so that if you have 
not changed them. the characters appear solid. However, 
the fill may be changed, to a different colour, to a pattern, or 
to a 'hollow' fill, and the outline may be changed independ-

ently to a different colour or style. 

attern 
Fed 

Letters 
TrÁîms--,-M-feqt wgr f, tpaztt-, if --41e a vy 

ch a rpictetilf/c1g 1{it;pi:g10 eltç4e 
the liàtfetrietivd-rtMiery'vsier' lecbteit,\tharaters .A11th an 
outline of one colour and a solid fill of another can be very 
effective without looking too fussy. In either colour or black 
and white, patterns can be given a transparent or opaque fill. 

A transparent fill lets text below show through. 
These effects are chosen from the PowerText Style dialog 

(see Figure 7.2). This can be produced either by clicking the 
Style button in the PowerText dialog, or by selecting 
PowerText Style from the Text menu. 
From this dialog, you can set the pattern and colour to fill 

the letters, the pattern and colour for the background, and 
the line style and colour for the letter outlines. You choose to 
set the effects for background or letters by selecting the 

Letter Style or Background Style option buttons. The 
background style is only in effect if the Background On box 

is checked. 
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The line style can be set for thickness, and whether it will 
be continuous or broken. Broken effects are often not very 
successful, but variations of width are very useful. You 
cannot set a transparent line style, but if you set the line 
colour to the same as a plain background colour, you can 
produce pattern-filled letters with no visible outline. 

Figure 7.2 The PowerText Style dialog 

Pattern-filled letters are effective in black and white. 

Pattern fills in colour can look fussy and overdone, especially 
if the outline is a different colour. However, an outline and a 
plain fill of a different colour can look very good, especially 
with bold text and a thick outline. Experimentation is 

recommended. 

Rotating and Sizing Frames 

PowerText frames can be rotated after they are on the page, 
whether or not a rotation angle was specified when 
producing the object. This is done by dragging on one of the 
frame handles' while holding down the control key. This 

explains why the control key cannot be used to resize a 
PowerText frame without altering the size of any Draw Mode 

graphics in it. 
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PowerText frames can be moved and resized in the normal 
way. When you resize a frame, what happens exactly 
depends on the type of object it contains. If the object is 
Fixed Size, enlarging the frame will place extra space around 
it. Making the frame smaller will reduce the frame around, 
and may eventually cause the object to be cropped (though 
the full object is still displayed on the screen, protruding from 
the frame - this may be a bug). If the object was produced 
with Preserve Aspect, it will expand to fill the frame in one 
direction, and space will be left in the other. If you chose Fit 
Frame, the aspect ratio will be distorted so that the object fits 
the frame in both directions. 
When Fixed Size and Preserve Aspect objects do not fit 

the frame, most will be centred in the direction in which 
space is left. However, Line - Left and Line - Right objects 
will be left and right aligned respectively. 

Creating a Drop Cap 
op caps are most readily created with PowerText. It 
s a case of drawing a frame where you want the letter 
o be, using PowerText to put the letter in the frame in 

the chosen size and style, and then deleting the first letter of 
the actual text. In practice, it is not much more difficult than 
this. 
The main problem is perhaps getting the text to flow close 

to the drop cap. A PowerText object does not have padding 
above or below the frame, but it does have horizontal 
padding. This can be reduced to zero in the Text Runaround 
dialog, with runaround left on. The text lines to the right of 
the drop cap will then be flushed left on the frame border. 
The Author does not like irregular left margins, but some 
people like to run text to follow the outline of large letters like 
T, L or A. You cannot draw a user-defined border in a 
PowerText object frame, so you must turn off text runaround 
for it, and draw another frame over it. This frame must be 
given a transparent background, text runaround must be on, 
and the padding should be reduced to zero. You can then 
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draw a user-defined border following the letter in the frame 
below. 

In the Author's opinion, the most effective drop caps are 
those which are reversed-out, that is, printed as white on 
black (or light colour on dark). You can do this with the 
PowerText style settings. You will find that the dark 
background will not completely fill the frame. This is because 
the background is only a 'strip' behind the text. There are 
three solutions to this problem. 

If you make the drop cap a Fixed Size object, you can 
reduce the size of the containing frame to fit around it, 
effectively cutting off the unfilled area. This is the simplest 
method, however, you are unlikely to get the frame to fit the 
background exactly. You will need to cut off some of the dark 
area, or leave some white space on one or more sides. You 
can experiment to find the best solution in your case. 
The frame background tint can be set to match the 

character background. This will leave a large area around 
the actual character. Combinations of this and the first 
method are possible. 
The third method is the most difficult, but the most flexible. 

The actual PowerText frame is set to have text runaround 
off, and you then draw another frame on top to exactly fit the 
area of the background. For this frame, text runaround is left 
on, but the padding is reduced to zero. or a very low level. 
The problem with the first two methods is that the text may 
be too close to the background area, merging with it, either 
above or below (remember, you cannot set vertical padding 
for a PowerText frame). With this method, vertical padding 
can be set for the top frame. 
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8. WINDOWS OLE 

One advantage of the Windows environment is the methods 
provided for communication between programs. Because 
more than one program can be loaded and running at once, 
data can be passed between them without the need to save 
it as files. Using these facilities can save time and effort. 
There are two methods which Pressworks can use. The 

first of these is the clipboard. This allows data to be cut or 

copied from an application and pasted into a Pressworks 
document, and also in the opposite direction in some cases. 

The second is Object Linking and Embedding (OLE). This 
allows a graphic to be included in a Pressworks document, 
but edited by the program used to produce it, and also allows 
several applications to share' a graphic, and for it to be 
updated in all of them if it is changed. Pressworks does 
support OLE for text, but this has limitations for a DTP 

program. 

The Clipboard 

There is just one clipboard for all applications running under 
Windows. Most programs can cut or copy data to the 
clipboard, and also paste data from it into documents. As 
well as being used to transfer data from place to place within 
one program (e.g. to move a frame from one page to another 
in Pressworks, the clipboard can be used to transfer data 
from one application to another. 
The clipboard can take data in several formats. Some of 

these formats are part of the Windows specification, and can 
be used by many Windows programs. These include bitmap, 
metafile and plain text formats. Programs can easily use 

these to transfer data, but in some cases the data transfer 
will be limited. For example, text formatting may be lost. 
Programs can also use private clipboard formats. For 

example, a word processor may register a format which 
allows text to be transferred with formatting intact. The 
format used for Pressworks frames is a private format. Such 
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formats cannot usually be used to transfer data between 
programs. If you copy data to the clipboard from one 
program, and find that Paste is disabled in another, it usually 

means the data has been rendered in a format the target 
application cannot use. However, sometimes programs 
written by the same software house can recognise each 
other's formats. For example, Pressworks can use private 
formats also used by Designworks. 
The clipboard can only take one item at a time. When you 

copy a new item to the clipboard, the existing contents are 
cleared. However, this item can be placed in several formats. 

These may include private formats and Windows formats. A 
well-written program will survey the formats offered, and, 
from the ones it can use, choose the one offering most 
features. This will happen automatically in most cases 
without the user being aware of it. 

AutoSketch for Windows is unusual in that it offers the user 
a choice of formats when copying data to the clipboard. You 

can choose either the Metafile or BMP formats. The best 
way to transfer an AutoSketch drawing to Pressworks is to 

copy it as a metafile. and paste it into the document. The 
only AutoSketch file format Pressworks can import (. sId) is, 
frankly, inadequate. However, AutoSketch also offers OLE. 

Object Linking and Embedding 

OLE provides a method of dynamic communications be-
tween programs. OLE objects come in two distinct types, 

Linked and Embedded. Both of these allow an object, 

normally a graphic in Pressworks. to be edited at any time 
during the creation of the containing document. The editing is 
done by the application used to create the object. 
There are some terms to be learned when using OLE. A 

client application is one which can include OLE objects in its 

documents. Pressworks is an OLE client. A server applica-
tion is one which can create OLE objects to be linked to or 
embedded in client documents. Server applications include 

Designworks, AutoSketch for Windows and Windows Paint-

brush. Some servers can only act as servers, and cannot 
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save or print files themselves. These include the Microsoft 

mini-applications MS Draw, MS Graph, MS Equation and MS 

VVordArt. These are included with Microsoft applications such 
as Word for Windows and Excel. These are sometimes 
called Embedded applications as they can only produce 
embedded objects. 

Embedding 

An embedded object belongs exclusively to the document in 

which it is placed. The data for it is saved in the document 
file, and is not available to other applications. To create an 

embedded object, you must draw and/or select a frame, and 

then choose Insert Object from the Edit menu. This produces 
the Insert New Object dialog (see Figure 8.1). This dialog 

Insert New Object 

Object Type: 
AutoSketch 
Equation 
Microsoft Drawing 
Microsoft Excel Chart 
Microsoft Excel Macrosheet 
Microsoft Excel Worksheet 
Microsoft Graph 
MS WordArt 

Cancel 1 

Help 

Figure 8.1 The Insert New Object dialog 

contains a list box with all the available server applications in 
it. The contents of this will depend on what you have 
installed on your machine. When new server applications are 
installed, they should be added to the list automatically. 
When you choose the server, it will be started for you, 

presenting an empty window ready for a new object. You 

then use the server application to create your graphic or 
whatever. On the File menu of the server, you should find an 
Update Link command (or similar wording). Choosing this will 
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place the object into the document. You should choose this 
periodically while working to save your work. You can also 
switch back to the client application to save the document as 
a security measure. Your work is only saved to disk by doing 
this. 
When you have completed the object to your satisfaction, 

you can choose the Exit and Return command from the 
server's File menu. You may be asked if you want to update 
the link at this stage, if you have modified the object since 
last doing so. The server application will then terminate, and 
you will be returned to the client, with the object displayed in 
its frame. 

If you want to edit the object subsequently, you can 
double-click on it in Frame mode. This will start the server 
application, with the object displayed in its window, ready for 
editing. After editing, it is a case of updating again, then 
returning to the client application. 
Generally, the only copy of the data for the object will be in 

the client document. However, some OLE servers will allow 
you to save the object to a file, in the server's native file 
format (or other formats it supports) before returning to the 
client. This can be useful for security, though it could be 
characterised as belt and braces. Such a file will not be 
updated automatically if you edit the object subsequently. 
With most servers, a good representation of the object will 

display in the frame. However, if you use Word for Windows 
to create a text object, all that will be displayed is the 
program's icon. Other text servers do this also, and this is 
not a great deal of use in a DTP program, so in this case 
OLE is best reserved for graphics. 
To embed an existing file, you must start the application 

which originally produced it, and load the file. The object is 
then copied to the clipboard, using the Copy command on 
the Edit menu. With some programs, you may need to use a 
command called something like Select All, to ensure all of 
the object is copied. At this point, you switch to Pressworks, 
starting it if necessary, and open the document to take the 
object. Select Frame mode, and then choose Paste from the 
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Edit menu. You will find the object will be added to the list of 

OLE objects in the browser. 
The object can now be placed in a frame like anything 

else. Either select or draw an empty frame, then click on the 
OLE object name in the browser. It will appear in the frame. 
If an empty frame is selected when you paste the object, it 
will be placed directly in it. 
A copy of the file data will be included in your document. 

You may edit this by double-clicking on the object as before. 
Any changes will be stored in your document when you 
choose to update, but the original file on disk will not be 

altered. 

Linking 

Object linking is used when the object is an existing file, and 
you do not want to place a copy of it in the client document. 

Linked files can be used by several client applications. Only 
one copy of the file exists on disk, as a normal file of the 
server application. If the file is changed, the changes will be 
reflected in all clients. Remember always that your applica-
tion does not have exclusive use of a linked object. 
Creating a link is similar to embedding an existing object, 

except that a different command is used for the paste stage. 

You start by running the server application. You can open an 
existing file, or create a new one, but you must save the 
object as a file from the server before creating the link. As 

with embedding, the object must be selected and copied to 
the clipboard. 

Pressworks must be running at this stage, with an empty 
frame ready to take the object. With this frame selected, you 
choose Paste Link from the Edit menu. The object will be 
added to the list of OLE objects, and displayed in the frame. 
As with embedded objects, you can edit linked objects by 

double-clicking them. Note that editing changes will be 
stored in the original disk file, not your document file, and will 
therefore be reflected in any other client applications linked 
to this file. Also, any changes made by other applications or 
by the server application will be reflected in your document. 
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For linking to work. the object's file must remain in the 
same place on the disk. If it is deleted or moved, the link will 
be broken. and the object will not be displayed. This means 
that a file with linked objects cannot be readily transferred to 

another computer, unless you also transfer the linked files. A 
copy of the server application must also be on the new 
computer, and the files must be in directories of the same 

name, and in the same relative positions. 

Sizing OLE Objects 

Frames containing OLE objects can be moved and sized by 
the usual means. The object will normally be sized to fill the 
frame. However, as with other things in Pressworks, you can 
choose whether or not to preserve the aspect ratio. This is 
done by choosing Picture Object Attributes in the Frame 
menu (see Figure 8.2). This dialog is substantially the same 
as for other pictures. You can choose to preserve aspect 

ratio by checking the check box. You will note that the Whole 

Figure 8.2 The Picture Object Attributes dialog 
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Pixel Scaling section in this dialog is greyed (i.e. unavail-
able). This would be expected for metafile-type objects. but 

is also true for servers which provide bitmaps (this dialog 
applies to a Windows Paintbrush object). Presumably, 
servers do not provide the information which would allow 
whole-pixel scaling. This may prevent the use of OLE in 

cases where this is important. 
You can also crop picture objects just like other graphics. 

As usual, the object itself is not altered. just the part 
displayed and printed. You can restore the full object by 
selecting the frame then clicking on the name in the browser. 

Why OLE? 

When considering whether to use OLE or to use an imported 
file, or to paste an item via the clipboard, you need to 

consider whether you will need to alter the item and your 
document file size. 

If items are imported or pasted, they cannot be changed. If 

changes are necessary, it is a case of making the changes 
outside of Pressworks, clearing the old item and importing or 
pasting the new. OLE allows the object to be edited simply 

by double-clicking the frame containing it. 
If you paste items into a document, and do not keep copies 

on file elsewhere, there is a security risk. Lose the document 
file and you lose everything. If you need to modify the item, 
you can only do so by copying and pasting it into a suitable 
application, if possible. 
OLE embedded objects may increase the size of a 

document file substantially. As well as the data for the object 

itself, a lot of other things can be included. In some cases, it 
is said that practically a complete copy of the server 
application is included, but the Author has not had this 
confirmed authoritatively. Linked objects do not have such a 
large overhead, but they can be modified by other applica-
tions linked to them. This can be both advantage and 
disadvantage. 
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GLOSSARY 

AMPERSAND This is the symbol Si', normally used in 
printing as an abbreviation for 'and'. 

ANSI The American National Standards Institute. The 
character sets used by TrueType fonts follow the ANSI 
standard. 

ARABIC NUMERALS The standard form of numerals, i.e. 1, 
2, 3, 4. 5, 6, 7, 8, 9, as distinct from roman numerals, made 
up from the letters i, v, x, m, c, and others. 

ARTWORK Graphics material in colour or black-and-white 
intended for reproduction, but not including photographs. The 
term mechanicals is used in the USA and UK. 

ASCENDER The part of a lower-case letter which extends 
above the body of the letter, up to the height of a capital 

letter. The letters b, d, h, (among others) have ascenders 
while a, e, and x do not. 

ASCII American Standard Code for Information Interchange. 
Pronounced 'askey'. This is the standard code for represent-
ing alphanumeric characters by numeric values within 

computers, and for sending text information between them. 
As well as representations of the alphanumeric characters, it 
also includes control codes, for line feed, carriage return, etc. 

ASTERISK The star symbol '*'. This is normally used as a 
reference to a footnote. Note that in printing the asterisk is 

normally placed high on the line, going wholly or partially 
above the top line of the lettering. Computer printers 
normally place the asterisk at mid-height on the line. 

AUTOFLOW The process whereby text can be made to flow 
through new frames and new pages (automatically added) 
when it overflows the frame(s) it is in. A time-saving facility. 

AUTOMATIC BACKUP A method of saving a file periodi-

cally while working on it. The auto-saved file can be used to 

recover work if a power cut or other hiatus occurs. 
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BACKING UP This means printing the second side of a 
sheet. Whenever possible, this is done so that the line 
positions on the two sides match. This gives a cleaner result, 

with less text showing through from the other side. 

BASELINE The line on which both capital letters and lower 
case letters stand. Any part of.a character extending below 
the baseline is a descender. When text is rotated, the angle 

of rotation is the angle of the baseline. 

BEZIER CURVE A type of curve used in some drawing 
programs. Said to be best for drawing 'real world' objects. 

BIT IMAGE An illustration in the form of a regular matrix of 
dots, each of which may be printed or not printed. In black 

and white illustrations, each dot corresponds to one binary 
digit (bit) in the digital electronic form. In colour and 

grey-scale images, one or more bytes are used. 

BITMAP An alternative name for a bit image, now becoming 

much more popular. 

BODY TEXT The main text of a story, as distinct from 
headings and captions. In DTP, Body Text is normally the 
default paragraph style. 

BOX A continuous rule around all four sides of a block of 

text. 

BOX OUT A section of text extracted from a story and 
placed in a box. Normally printed in a bold (often italic) font, 
and given other special treatment, to make it stand out. A 

form of heading, intended to attract the eye. 

CALLIGRAPHIC Describes a typeface design based on 
classical handwritten letter forms, e.g. Zapf Chancery. 

CAP HEIGHT The height of capital letters in a font, normally 

expressed in points. 

CAPTION Text describing, or giving the context of, an 
illustration. Normally placed below it. and often in italics. 

CHARACTER An individual letter. figure or symbol in a type 
font. 
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CHARACTER SET All the characters included in a font. 

There are several standard character sets, and some fonts, 
such as symbol fonts, have a unique character set. 

CLIPBOARD A repository for items cut or copied from 

documents, which can be pasted elsewhere into other 
documents or to other programs. 

COLUMN RULE A fine vertical rule used to separate 

columns of text. 

CONTINUOUS TONE Illustrations including shades of grey 
as well as black and white, and distinct from line illustration. 
(Illustrations in this context include photographs.) Normally 
reproduced as half-tone blocks 

CROPPING Cutting an illustration to fit the area available, or 
to remove extraneous material. 

DESCENDER The part of lower-case letters such as q, g, 
and y. which extends below the baseline. The only upper-
case letter with a descender is Q (Though the G may also 

have one in some calligraphic italic forms). 

DITHERING The simulation of half-tones in a bit-image, by 
varying the number of dots printed in different areas of the 
image. 

DROP CAP A large capital letter at the start of a paragraph, 
with its top edge aligned with the top edge of the first line of 
text in the paragraph. Commonly used as a decorative 

feature at the beginning of a story. 

DUPLEX Printing on both sides of a sheet of paper. Some 
computer printers can do this (mostly lasers). 

EM The square of the body of a type. An 'ern space is a 
space equal in width to a lower-case ' m'. Letter spacing, 
word spacing and kerning are often expressed in em units. 

EN Half the square of the body of a type. An 'en space' is a 
space equal to the width of a lower-case ' n'. 

FOLIO A page number printed on the page. 
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FOOTER A running heading printed in or immediately above 
the foot of every page in a document (e.g. carrying the page 
number). 

FORMAT The size of a document (page size). The 
orientation of pages (i.e. vertical format, horizontal format). 
The arrangement of text and headings on a page. 

FONT The complete character set of a particular typeface in 
a particular size and style. In DTP, the target device (i.e. 
screen, printer) may also be included in the specification. 

FRAME An area, indicated by a box on screen, in which a 
text or graphic item may be placed. Items are moved on a 
page by moving the containing frames. 

GRAPHICS Display material made up of lines and/or dots, 
as distinct to alphanumeric characters, but including 'block 
graphics' made up of predefined shapes and patterns used 
like alphanumeric characters. 

GRID A system of regularly-spaced lines (visible or invisible) 
on the computer screen, to which the cursor can be made to 
'snap'. They are used to simplify alignment and accurate 
drawing, and also the placing of text columns, etc. 

GUTTER The space between text columns. The fold 
between pages. 

HALF-TONE An illustration, especially photographs, broken 
up into dots of varying size for reproduction. 

HANDLE A square block on a frame used to resize it. 

HANGING INDENT Text, normally the first line of a 
paragraph, set beyond (to the left of) the left margin used for 
the remainder of the text. 

HEADER A running title printed in or just below the head of 
every page in a document, e.g. carrying the book title or 
chapter number. 

INDENT Space left between the left margin and the left end 
of a text line, commonly used at the start of each paragraph. 
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ITALIC The sloped or oblique version of a typeface, with 

letter forms based on handwritten rather than engraved 

forms. 

JUSTIFICATION The action of fitting text to a margin or 
margins. Text may be left-justified, right-justified, or both, or 
unjustified. Where text is justified to both margins, extra 
space is inserted between words and letters to pad lines out 

to the required length. 

KERNING Adjusting the spacing between characters. In 

particular, reducing the spaces between adjacent characters 
with sloping sides (e.g. AW) to improve the appearance. 

KERNING TABLE A table giving recommended amounts by 
which the space between certain pairs of characters should 
be adjusted in a particular font. 

LANDSCAPE A common description for a document which 
is wider than it is high. Photographs or other illustrations 
which are wider than high are also described as 'landscape 
format', as opposed to 'portrait format'. 

LAYOUT The arrangement of text, illustrations, decorative 

features and white space on a page. 

LEADERS Lines of dots or other characters, such as 

dashes, used to lead the eye across the page from one 
piece of text to another. They are, for instance, frequently 
used between the chapter names and the corresponding 
page number on contents pages. 

LEADING (pronounced like the metal lead) The amount of 
vertical space between one line of text and the next. It is 
normally expressed in points, including the height of the text. 

Set text may be described, for instance, as ' 10 on 12-point', 

meaning that the characters are 10-point and the leading is 
12 points. 

LETTER SPACING The spacing between letters. The use of 
this term normally implies that the spacing has been made 
wider than normal, to stretch the length of a line of text to fit 
the margins. 
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LINE ART (or line illustration). A drawing made up entirely of 
lines and solid areas without any graded half-tones, i.e. pure 
black and white. 

LOGO A name or word in a specific style of lettering and 
design, used as a trademark. The term Logo' is also 
frequently used to describe a non-text company symbol, but 
strictly speaking this is incorrect. 

LOWER CASE The small letters in a font of type. The term 

comes from the days when the metal characters were stored 
in wooden cases. The capital letters were stored in the 
'upper case' and the small letters in the 'lower case'. 

MARGIN The area between the text and any edge of the 
page (but, strictly, not the space between columns of text). 

METAFILE A file, on disk or in memory, containing drawing 

instructions. Used to store line-art in digital form. Can also 
contain fully-formatted text, including special effects. 

ORPHAN A single line of a paragraph left at the bottom of a 
page. A heading at the very bottom of a page. 

OUTLINE CHARACTER A character which is drawn in 
outline only, and not filled in. Can be produced with 
PowerText from a normal font. Fonts of outline characters 
are available. 

OUTLINE FONT Generally, a font in computer-readable form 
in which each character is described as a series of lines and 
curve. These are now normally called 'scalable fonts' to 

avoid confusion with fonts of outline characters. 

PICA A typographical measure equal to 12 points (approx. 

1/6 inch.) 

PIXELS Picture Elements. The individual points on a 
computer screen. The individual dots making up a digitised 
image when in visible form. 

POINT The unit of typographical measure, approximately 
equal to 1/72 inch. 

PORTRAIT A document which is higher than it is wide 
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PROOF Any test printing. A test printing to be checked for 

mistakes. 

RANGE (left/right). This means aligning text to the left or 
right margin respectively, with the other margin being left 
unjustified. 

REVERSING OUT Printing white text on a black or shaded 
background. 

ROMAN FIGURES Figures made up from the characters 

i,v,x,c,m, as opposed to Arabic figures. 

RULES Lines of various thicknesses, including dotted and 
dashed lines, and multiple lines, used as dividers, boxes, 
and decorations. 

RUN ON Text of a paragraph continuing from a heading on 

the same line ( like these glossary entries). Can also mean 
extra copies printed at the end of a print run. 

RUNNING HEADER/FOOTER Text printed at the head or 

foot of every page of a document (may be omitted on blank 
pages or the first pages of chapters, etc.) 

SANS SERIF (SANSERIF) Descriptive of a plain typeface, 
without decorative serifs (e.g. Helvetica, Univérs, Futura). 

SCALABLE FONT A font described as outlines, which can 

be scaled to any required size. TrueType, PostScript type 1 

and Bitstream Facelift fonts are scalable. 

SEMI-BOLD A typeface weight between normal and bold. 

SERIF The small decorative strokes and features at the ends 
of the main strokes of letters. 

SERIFIED Descriptive of a typeface which has serifs (e.g. 
Times Roman, Palatino, Century Schoolbook). 

SIMPLEX Printing on one side of the paper only. 

SKEW Slanting of letters forward or backward, like italics 
and reverse italics. Also called Stress. 

SMALL CAPS Letters of capital form, but the height of a 

lower case x. 
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SPLINE CURVE A method of curve drawing used mostly in 
CAD programs. Most suitable for technical drawing. 

TINT An even tone made up of fine dots or lines, frequently 

as a background to headings. 

TYPEFACE The design of a set of characters comprising a 

font. The aspect of a letter form which has been designed. 

TYPESETTING Preparing text in some form, such that it can 
be printed by some method. 

UNJUSTIFIED Text which is aligned to the left margin but 

left ragged on the right margin. Left-ranged text. 

UPPER CASE Capital letters. See lower case' for an 

explanation. 

WEIGHT Of typefaces, the degree of boldness of the 
typeface, ranging from extra-light to ultra-bold. Of paper, a 
measure of the thickness of the paper, expressed usually in 

grams per square metre or pounds per ream. 

WHITE SPACE The blank areas on a page around the text 
and illustrations. 

WIDOW The last line of a paragraph appearing on its own at 

the top of a page. 

WINDOW A limited active area on the computer screen. 
Many computers allow multiple windows on the screen at 
one time. 

X-HEIGHT The height of a lower-case x'. 
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A Concise Introduction to 
Pressworks 

Pressworks from GST is the latest version of Timeworks Desktop 
Publisher, one of the most popular DTP programs in the UK. This book is 
intended to help you get started with Pressworks and DTP. 

III The book describes the steps necessary to produce a document with 
Pressworks. It covers all the stages from creating a page layout to adding 
finishing touches. It covers the 'why' and 'when' as well as the `how'. 

El The book covers:-

The software which can be used with Pressworks 

Designing pages and saving templates 

Preparing and using text 

Adding illustrations 

Fonts and Typography 

Assembling the document 

E This book also covers the advanced features of PowerText and OLE. 
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